The PMMail Main Window

The PMMail main window is the core to accessing all of the features of PMMail. The main
window is made up of the following five parts:

The Main Menu
The Button Bar
The Account/Folder Tree View (on the left)

The Message List (on the top right

The Message Preview Pane (on the bottom right)
The Status Bar



The PMMail Main Menu

It is important to note that there are several ways to perform certain actions. The "starting point" of the
main window is the menu bar. Every option setting and action is either listed under a menu choice, or
can be reached from within a menu choice. The menu bar has seven top level menus to help the user
perform actions. To see a detailed description and view the contents of one of these menu choices,
select one from the following list:

PMMail - which deals with global settings and global actions of the application.

Accounts - This menu contains all of the choices that deal with the multiple account features of PMMail.

Folders - This menu contains all of the choices that deal with the multiple folder features of PMMail. All
of these choices operate on the folder structure within the currently active account.

Messages - Like the Account and Folder choices, this menu has all of the choices necessary to perform
actions on messages and take advantage of many of PMMail's built in message processing functions.

Tools - PMMail has several built in tools that will aid the user in keeping track of the people e-mailed most
often, finding e-mails that were sent to them, and importing e-mail data from other programs.

Window - The first choice under this menu is Preview Pane. Choosing this option turns on and off the
message preview pane. The other choice under this menu is to Save The Window Position. This
remembers the size and placement of the PMMail main window and reopens it to the same place the next
time you open the application.

Help - You can reach this help from this menu choice.

Main Window Topics: button bar , account/folder view , message list , message preview pane , status bar



The Message Preview Pane

PMMail’s message preview pane is a static window that will show you the body of the e-mail message
that is currently selected. No header or attachment information will be displayed in this window, however
it does work just like the message body pane in the Read Window. All URLs and E-mail addresses are
active, and you can select text and perform selective quoted replies.

If a message is displayed in the preview pane for more then five seconds, it will be marked as read.

To turn off the preview pane, simply select Window -> Preview Pane from the main menu.

Main Window Topics: main menu , button bar , account/folder view , message list , status bar



Main Menu - PMMail

PMMail - which deals with global settings and global actions of the application. Once this menu choice
is dropped down, you will be able to choose one of the following:

Fetch All Accounts - This choice will cycle through all of your accounts (excluding ones that are
both closed and password protected) and perform a fetch for that account.

Properties - This choice will bring up the PMMail Global Settings dialog which will allow you to
configure the global behavior of the application and how it interacts with other applications.

Exit - This choice exits PMMail.

Main Window Topics: main menu , button bar , account/folder view , message list , message preview
pane , status bar



Main Menu - Accounts

Accounts - This menu contains all of the choices that deal with the multiple account features of PMMail.
This menu will let you perform the following actions:

Fetch - This will immediately attempt to connect and download all of the mail from the mail server
specified to receive the mail for that account.

Send Queued Messages - The application will immediately attempt to send all messages waiting
in the Outbox.

Remote Control - This option opens the Remote Control dialog for the account. The Remote
Control will allow you to see pertinent information about the e-mail waiting to be fetched from the
mail server. You can also use the Remote Control to selectively download certain e-mail
messages, or delete them without having to download them.

Account Error Log - This brings up a list of all of the network and other problems that have been
encountered by this account since it was created. The error and the time and date at which it
occurred is recorded in this list.

Create - This will bring up the Create New Account dialog from within which you will be able to
configure and add a new account to PMMail.

Delete - This choice will delete the currently active account.

Properties - This will bring up the Account Settings dialog from which you will be able to modify
the current information about the account such as e-mail address, mail servers to connect to, and
the various attributes of an account.

Set As Default - Select this option to make this account’s Inbox the selected folder when the

program starts up.

Main Window Topics: main menu , button bar , account/folder view , message list , message preview
pane , status bar



Main Menu - Folders

Folders - This menu contains all of the choices that deal with the multiple folder features of PMMail. All
of these choices operate on the folder structure within the currently active account. This menu will let
you perform the following actions:

Create At Root - This will display the New Folder dialog from within which you can fill in the
information about the folder to be created. Once this is done, the folder becomes a root level
folder (i.e. its parent is the account, so it will be displayed by clicking the (+) next to the account
name.)

Create As Child - This will display the New Folder dialog from within which you can fill in the
information about the folder to be created. Once this is done, the folder becomes a child of the
currently active folder. It can only be displayed by clicking the (+) next to its parent.

Delete - This will delete the currently selected folder and all of its contents. So, be careful that
the proper folder is selected before you choose this menu option.

Re-Index - This choice will scan through the e-mail on the hard drive in the directory
corresponding to the currently active folder and rebuild the index file for that folder. This could
potentially clean up a folder that is not displaying the correct information about the e-mails within
it.

Properties - This will bring up the same dialog as creating a new folder, except with all of the
information filled in for the currently active folder. You can change this information from within
this dialog.

Main Window Topics: main menu , button bar , account/folder view , message list , message preview
pane , status bar



Main Menu - Messages

Messages - Like the Account and Folder choices, this menu has all of the choices necessary to perform
actions on messages and take advantage of many of PMMail's built in message processing functions.
PMMail will allow you to do the following with the messages:

New Message - This will open a new blank message in the standard PMMail "Compose" window.
You can fill in the header information, type your message, and send the e-mail.

Reply - This will send a reply to the original sender of the message. You can choose (by clicking
on the arrow after the text) to either include or not include the original text of the message that
you are replying to.

Reply To All - This will send a reply to the original sender and all of the people the message was
originally sent to. It will also Cc the reply to anyone who was Cc'd the original message. You
can choose (by clicking on the arrow after the text) to either include or not include the original text
of the message that you are replying to.

Forward - This will forward the message to another e-mail address. You will be able to edit the
message before you send it. Note that all attachments in the message to be forwarded are
forwarded along with the message text.

Bounce - This is like a forward, except that the message is sent untouched to the receiver of the
bounce. This feature, unlike the forward feature, leaves no indication that this message was
forwarded in the body of the message.

Read - This will display the currently selected message.

View Attachments - This will bring up a container that holds icons representing each attachment
in the currently selected message. You can save or open any of the attachments just as you can
from the built in PMMail "read message" window.

Mark as read - This sets the "read" bit for the message. If you are viewing the read status in the
container, you will notice the envelope will be missing for that message.

Mark as unread - This turns off the "read" bit for the message. If you are viewing the read
status in the container, you will notice an envelope appear in that column for the current
message.

Add User to Address Book - This will bring up the "new address" dialog with some of the
information already filled in. Once you are done editing the entry, the person who sent you the e-
mail will have an alias for their e-mail address in the PMMail address book.

Move - This will bring up the Move dialog where you will be asked to choose the folder to which
the message will be moved. This can also be done by dragging and dropping the message onto
another folder. Note that messages can be moved to any folder in ANY account within PMMail.

Copy - This will place a copy of the message in another folder. The destination folder is chosen
just as in Moving a message.

Print - This option will bring up the Print Message dialog where you will be asked to choose a
printer.



Filter - You will be presented with a flyout menu containing the description of all of your filters that
are defined as manual. You can use this flyout menu to select to run just one particular manual
filter, or you can select the All choice to run all filters listed against the message(s) selected.

Select All - This will highlight all of the e-mail in the current folder and, until they are deselected,
all actions will be taken on all of the e-mail messages in the folder

Delete - This will delete the currently selected e-mail. This means that the message will be
moved into the trash folder for the current account. Depending how you have set up the trash
removal for this account, the message may or may not be deleted from your hard drive.

Main Window Topics: main menu , button bar , account/folder view , message list , message preview
pane , status bar



Main Menu - Tools

Tools - PMMail has several built in tools that aid the user in keeping track of the people e-mailed most
often, finding e-mails that were sent to them, and importing all of the data from other e-mail programs.
The choices under the tools menu are:

Address Book - This opens the PMMail address book manager.
Find - This opens the PMMail Find Facility. This will help locate an e-mail within PMMail.

Migrate - You can Migrate all of your accounts, folders, e-mail and address books from other
popular e-mail clients such as Eudora, Microsoft Internet Mail, and Netscape.

Main Window Topics: main menu , button bar , account/folder view , message list , message preview
pane , status bar



Main Menu - Help

Help - You can reach this help from this menu choice. You can get help on a variety of topics:
PMMail 2000 Help - This selection brings up the online help for the main window.
Help Topics - Shows the table of contents for the Online Help

Keyboard - This brings up the help panel that describes all of the keyboard shortcuts for this
window.

How To Use Help - This option brings up the online help topics that describe how to use the
Windows Help System.

Blueprint Software Works On The Web - You can use this menu to get to the Blueprint
Software Works Homepage, the PMMail 2000 Homepage, or the online PMMail 2000 Frequently
Asked Questions list.

About - This brings up the About dialog that has information about
the product and its creators.

Main Window Topics: main menu , button bar , account/folder view , message list , message preview
pane , status bar



The PMMail Main Window Button Bar

The Main Window Button Bar is located directly under the Menu Bar. This has several buttons
on it with pictures representing the actions of the button. These are just a quick way of getting to some
of the more frequently used menu items. Clicking them has the same effect as choosing an option from
the menu. To find out what each one does, place the mouse cursor over the button. The "fly over help"
will popup underneath the mouse cursor after a second or two. In this popup text box there will be a brief
description of the action taken when the button is clicked. The buttons perform the following actions:

/4 Account -> Fetch
‘= Account -> Send Queued Messages
=y Message -> Create New Message
£ Message -> Reply
2 Message -> Reply to All
%' Message -> Forward
=t Message -> Move
= Message -> Copy
=4 Message -> Delete
& Message -> Print
%® Tools -> Address Book

% Help -> Main Window Help

Main Window Topics: main menu , account/folder view , message list , message preview pane , status
bar



The PMMail Account/Folder Tree View

The Account region has a tree view of all the accounts and of the folders for each account. In the account
region you might notice that the folder icons, and account (person) icons sometimes change color. The
changes in icons are used to indicate the current status of an account to the user. Here is brief
explanation of what every color means:

Yellow - This is the default color.
Green - This means there are unread messages in folder (if you set the folder to indicate unread mail.)

Red - This means there are messages in the folder, either read or unread (if you set the folder to indicate
any mail.)

Main Window Topics: main menu , button bar , message list , message preview pane , status bar



The PMMail Message List

The message region has all of the information that you have specified to be displayed about each
message. To change what is displayed in this region, edit the PMMail Global Settings, in PMMail ->
Settings. Also, note that all fields that show the sender's name will show the receiver's name instead, in
the Outgoing and Sent folders, for every account.

Each row of information in the message region represents a message. You can set up (via
PMMail->Settings->Message List) what information will be displayed for each e-mail. As well, the
headings of each column can be clicked to change the sort order and they can be dragged and dropped
to change their position. There are two columns that have icons instead of textual information. The
Attachment column will be empty for e-mails that do not contain any attachments, or will have the same
icon that appears at the top of this column for those e-mails which contain an embedded attachment.Also,
the Read Status has several states. Any unread message will have an envelope in that column. This
envelope can be one of three colors, red, yellow, or blue, each representing a different priority of the
message. Red is for high priority, yellow signifies normal priority, and blue signifies low priority. If a
colored dot appears, the message has a priority other then normal, and has been read. A curved left-
pointing blue arrow in this column implies that the message has been replied to.

The time and date columns in PMMail 2000 are user configurable. To change the formatting of
the date and/or time strings, simply go to the Windows Control Panel and click on the Regional Settings
icon. A settings notebook will appear with several different tabs. Click on the Date tab to change the
date formatting, and the Time tab to change the time sting formatting. You can get further assistance
from the Windows Help System in the settings dialog.

Main Window Topics: main menu , button bar , account/folder view , message preview pane , status bar



The PMMail Status Bar

As mentioned above, a status bar is located across the bottom of the window. This displays three
different pieces of information. The first field (from left to right) contains some statistics for the current
folder you are in. PMMail will tell you the number of messages in the folder, as well as the current
number or unread messages that folder. The second field displays the current Fetch status, and the third
contains the Send status. If there is a networking problem, there will be instructions in these status bars.

Main Window Topics: main menu , button bar , account/folder view , message list , message preview
pane



The PMMail Message Read Window

Like all of the other PMMail windows, the Read Message Window has several parts to it. First, it
has the menu bar with the quick access button bar directly below it. Underneath the button bar is the
header layout area of the message. Directly underneath the subject of the message, there is a
horizontal bar that you can click and drag up or down to resize the addressing and subject area.

Underneath this horizontal split bar, you will see the large text reading region with a horizontal
split bar running along the bottom edge. You can grab this and drag it up or down to resize the test
reading region to make more room for the File Attachment window to the bottom of the edit region. If
there are attachments in the Files area, you can double click on one to open it automatically. PMMail will
decode it, and open the attachment with the program you set up to handle that attachment type.

Running along the bottom of the New Message Window is the status bar. The status bar
contains the fly over help for the button bar. Also, if the message was PGP encrypted, the PGP
information will appear in this status area.

To see more information about each of the parts described above, click on one of the following
window parts:

The Main Menu

The Button Bar

The Header Information Pane
The Message Body Text Pane
The Attachment Pane

The Status Bar



The Read Window Main Menu

From the read window menu, you can perform a variety of actions on the current message, as well as
navigate to read other messages, and change several properties of the read window. All of the actions
are categorized under the following main menu headings:

Message - This contains all of the actions you can perform on the message as a whole.

Edit - All of the editing functions that can be applied to a read only text field are options under this menu.

Attachments - All of the choices needed to manipulate the attachments in the "Files" region of the Read
Window.

Tools - PMMail provides the user with several tools to make keeping track of e-mail addresses easier.

Window - This has all of the options for dealing with the placement and contents of the window.

Help - You can reach this help from this menu choice. You can get help on a variety of topics:

Read Window Topics: button bar , header information pane , message body pane , attachment pane ,
status bar



Read Window Menu - Message

Message - This contains all of the actions you can perform on the message as a whole.

Reply - This will send a reply to the original sender of the message. You can choose (by clicking
on the arrow after the text) to either include or not include the original text of the message that
you are replying to.

Reply To All - This will send a reply to the original sender and all of the people the message was
originally sent to. It will also Cc the reply to anyone who was Cc'd the original message. You
can choose (by clicking on the arrow after the text) to either include or not include the original text
of the message that you are replying to.

Forward - This will forward the message to another e-mail address. You will be able to edit the
message before you send it. Note that all attachments in the message to be forwarded are
forwarded along with the message text.

Bounce - This option is much like forwarding, however the message stays completely intact,
except for the “To:” field is changed to the bounce recipient’s e-mail address. It appears as
though the original sender sent the e-mail directly to the bounce recipient. This is very useful
when redistributing e-mail.

Delete - This will delete the currently selected e-mail. This means that the message will be
moved into the trash folder for the current account. Depending how you have set up the trash
removal for this account, the message may or may not be deleted from your hard drive. You can
choose to either view the next message in the list, the previous message in the list, or just close
the Read Window after the deletion takes place.

Move - This will bring up the Move dialog where you will be asked to choose the folder to which
the message will be moved. This can also be done by dragging and dropping the message onto
another folder. Note that messages can be moved to any folder in ANY account within PMMail.
You can choose to either view the next message in the list, previous message in the list, or just
close the Read Window after the move takes place.

Up - View the previous message in the message list.

Down - View the next message in the message list.

Save - You can save the body of this message to a text file via the standard WINDOWS "Save
As" dialog.

Append - You can append the body of this message to the end of another text file via the
standard WINDOWS "Save As" dialog.

Externally Edit - View this message in the predefined external editor.
Print - This option will bring up the Print Message dialog where you will be asked to choose a
printer. This can also be accomplished by dragging and dropping a message to any WINDOWS

printer object.

Print (Default) - This option immediately prints the current message to the WINDOWS default
printer.

Close - Closes the window.



Read Window Topics: main menu , button bar , header information pane , message body pane ,
attachment pane , status bar



Read Window Menu - Edit

Edit - All of the editing functions that can be applied to a read only text field are options under this menu.
Copy - Copies the selected text to the Windows clipboard.
Select All - Selects the whole body of the message.

Find - Find the first occurrence matching the search parameters defined in the Find dialog. The
find starts its search at the current cursor position.

Find Next - Finds the next occurrence of the text defined in the Find dialog. The find starts at
the current cursor position.

Read Window Topics: main menu , button bar , header information pane , message body pane ,
attachment pane , status bar



Read Window Menu - Attachments

Attachments - All of the choices needed to manipulate the attachments in the "Files" region of the Read
Window.

Save Selected Attachment - Once an attachment icon is selected, it can be saved via the
standard WINDOWS "Save As" dialog.

Open Selected Attachment - Once an attachment icon is selected, it can be opened with the
MIME associations. This can also be accomplished by double clicking the icon.

Read Window Topics: main menu , button bar , header information pane , message body pane ,
attachment pane , status bar



Read Window Menu - Tools

Tools - PMMail provides the user with several tools to make keeping track of e-mail addresses easier.
Add User To Address Book - This will bring up the "new address" dialog with some of the
information already filled in. Once you are done editing the entry, the person who sent you the e-
mail will have an alias for their e-mail address in the PMMail address book.

Add Sender To Group - This brings up a listbox containing all of the groups in all of your address
books, and allows you to add the sender to the group selected.

Add Public Key To Keyring - If the message is properly signed with a PGP public key, you can
add the signatures key to your keyring. (PMMail 2000 Professional)

Address Book - This opens the PMMail Address Book.

Read Window Topics: main menu , button bar , header information pane , message body pane ,
attachment pane , status bar



Read Window Menu - Window

Window - This has all of the options for dealing with the placement and contents of the window.
View Full Header - This choice will display the entire header and body of the e-mail.

View Full Message - This choice will display the whole message that was downloaded from the
mail server in its original form.

Save Window Position - Once this is chosen, PMMail will immediately memorize the current
window position and size of the Address Book Window. All subsequent times the Address Book
is opened, it will appear in the same place, until it is moved and this choice taken from the menu
again.

Read Window Topics: main menu , button bar , header information pane , message body pane ,
attachment pane , status bar



Read Window Menu - Message

Help - You can reach this help from this menu choice. You can get help on a variety of topics:
PMMail 2000 Help - This selection brings up the online help for the Read window.
Help Topics - Shows the table of contents for the Online Help

Keyboard - This brings up the help panel that describes all of the keyboard shortcuts for this
window.

How To Use Help - This option brings up the online help topics that describe how to use the
Windows Help System.

Read Window Topics: main menu , button bar , header information pane , message body pane ,
attachment pane , status bar



The PMMail Read Window Button Bar

The button bar contains, from left to right, the following menu shortcuts:
£4 Message -> Reply

¥ Message -> Reply to All

% Message -> Forward

=4 Message -> Create New Message

= Message -> Edit Externally

*& Message -> Print

Edit -> Copy

4 Message -> Delete And Down (view next message)
>4 Message -> Delete

7 Message -> Delete And Up (view previous message)

2 Message -> Move And Down (view the next message)
= Message -> Move

& Message -> Move And Up (view the previous message)
=4 Message -> Down (view the next message)

Y g Message -> Up (view the previous message)

= Window -> View Full Header

>4 Help -> Help on the Read Window

Read Window Topics: main menu , header information pane , message body pane , attachment pane ,
status bar



The Read Window Header Information Pane

Directly below the button bar in the Read Window, you will see the PMMail Read Window Header
Information Pane. In this pane, you will see all of the important information contained in the header of
the e-mail. The size of this pane can be changed by grabbing the split bar directly below the subject text
and dragging it up or down. You should notice that the size of the addressing list boxes changes. To
see more addresses without having to scroll, simply pull down on this resize bar, and to see less of the
header information, and more of the message text, raise the bar up.

The header information is laid out with the sender’s information at the top with the senders name
and e-mail address in the “From:” field, and the date and time the message was sent in the “Date:” field.
Note that this date/time may be different than the displayed date in the Main Window message list. This
is because the date shown in the header control is the raw date (relative to the sender’s time zone) field
of the message header, while the date displayed in the main window is normalized to the receiver’s time
zone.

Below these two fields is the addressing information. There are two list boxes, labeled “To:” and
“CC:”. The “To:” box shows all of the people to whom the e-mail is addressed, while the “CC:” box
shows the email address of everyone who was Carbon Copied on the e-mail. Carbon copying is
generally used to tell someone to take note of the e-mail, but no real action or reply is needed, unless
explicitly stated in the e-mail (NOTE: this is not a fixed standard, but rather a guide that suggests when to
use To and when to use CC.)

Finally, at the bottom of this pane, you will see the “Subject:” of the e-mail, which is also in the title
bar of the message window. As stated before, below the subject is the resize bar for changing the size of
the header pane. If you resize the header, and want the new size to be the default size for every PMMail
Read Window, you can select Window -> Save Window Position.

Read Window Topics: main menu , button bar , message body pane , attachment pane , status bar



The Read Window Message Body Text Pane

NOTE: There are two features that can be used on text selections. The first one is to reply to a
message and only quote specific text: to do this, select the text to quote, and then choose to reply (or
reply to all) to the message. The second is the Right Mouse Click popup menu for selected text. If text is
selected, PMMail 2000 will extract and display all e-mail addresses and URL Web Addresses in that text.
You can select to either send an e-mail or place the e-mail address in an Address Book. You can also
have your default web browser open and go to the URL(s) that PMMail has extracted.

Read Window Topics: main menu , button bar , header information pane , attachment pane , status bar



The Read Window Attachments Pane

If there are attachments in the Files area, you can double click on one to open it automatically. PMMail
will decode it, and open the attachment with the program you set up to handle that attachment type.

You can also click the right mouse button on an attachment icon and bring up a menu with choices similar
to those in the Attachments menu. This menu offers you quick access to the “Open” and “Save” actions
for an attachment, as well as an option to save the attachment to the location most recently used to save
an attachment, and finally you can choose to save the attachment to the desktop.

Read Window Topics: main menu , button bar , header information pane , message body pane , status
bar



The Read Window Status Bar

Running along the bottom of the New Message Window is the status bar. The status bar
contains the fly over help for the button bar. Also, in PMMail 2000 Professional, if the message was PGP
encrypted, the PGP information will appear in this status area.

Read Window Topics: main menu , button bar , header information pane , message body pane ,
attachment pane



The PMMail Message Compose Window

Like all of the other PMMail windows, the New Message Window has several parts to it. First,
there is the the menu bar with the quick access button bar directly below it. Underneath the button bar is
the addressing and subject area of the message. Directly underneath the subject Entry field, there is a
horizontal bar that you can click and drag up or down to resize the addressing and subject area.

Underneath this horizontal split bar, you will see the large editing region with a horizontal split bar
running along the bottom edge. You can grab this and drag it up or down to resize the edit region to
make more room for the File Attachment window to the bottom of the edit region. If you click with the
right mouse button in this area, you will get a popup menu with a list of your canned replies. Selecting
one of these will place that canned reply's text into the edit field at the current cursor position.

Next comes the attachment area, to which attachments can be dragged and dropped and in which file
icons will be placed when they are attached to an e-mail

Running along the bottom of the New Message Window is the status bar. The status bar
contains information about options and various setting of the new e-mail..

For more information on any part of this window, select from the following list of window areas:

The Main Menu
The Button Bar

The Addressing Pane

The Message Body Editor
The Attachment Pane

The Status Bar



The PMMail External Edit Compose Window

Like all of the other PMMail windows, the New Message Window has several parts to it. First,
there is the the menu bar with the quick access button bar directly below it. Underneath the button bar is
the addressing and subject area of the message. Directly underneath the subject Entry field, there is a
horizontal bar that you can click and drag up or down to resize the addressing and subject area.

Underneath this horizontal split bar, you will see The file attachment area. This area will be
directly below the addressing information. This area is where attachments can be dragged to and files will
be placed when they are attached to an e-mail. The next two paragraphs describe the external editing
process. Although you can type the body of the message in an external editor, PMMail must still be told
all the header information for the message. This dialog is designed to obtain all of the information for a
message except for the body text. As well, PMMail allows the ability to perform the same actions and
have the same functionality with the messages (obtained via the button bar and menus) as you do with
internally edited message. Such things as the spell checker, priority setting, and word wrap features are
still available to you, even if the message is edited outside of PMMail.

When you are ready to compose the mail, click the third button from the left (Externally Edit) or
choose message -> externally edit. Once you have finished the e-mail's body in the external editor,
save it, and close down the editor. You are then brought back to this dialog. The "Compose" button
now reads "Send". Double check all of the header and addressing information and correct any
addressing mistakes or take advantage of PMMail's tools for the built in editor at this time. When you are
sure all of the information is correct, click the "Send" button.

Running along the bottom of the New Message Window is the status bar. The status bar
contains information about options and various settings of the e-mail.

For more information on any part of this window, select from the following list of window areas:

The Main Menu
The Button Bar
The Addressing Pane
The Attachment Pane
The Status Bar



The Compose Window Main Menu

The menu choices in the menu bar of the Compose Window are:

Message - This contains all of the choices dealing with the message as a whole. From within it
you can:

Edit - This menu holds all of the standard editing controls for the PMMail built-in editor.
Attachments - All of the attachment options can be reached from within this menu.

Options - This menu allows you to choose several attributes of the outgoing message such as
priority and word wrapping.

Signature - Either choose one of the signatures to append to the end of this message, or to
create a new signature.

Tools - PMMail 2000 offers several tools to the user to help create an e-mail.
Window - This has all of the options for dealing with the placement and contents of the window.

Help - You can reach this help from this menu choice. You can get help on a variety of topics:

Compose Window Topics: button bar , addressing pane , message editor , attachment pane , status bar



Compose Window Menu - Message

Message - This contains all of the choices dealing with the message as a whole. From within it you can:
Send - Send the message over the network to the receiver

Save - The message is saved for later editing and sending. The message can be found saved in
the Outbox of the account it is being sent from.

Externally Edit - Open up the user specified external editor for further editing/composing of this
message.

Print - This option will bring up the Print Message dialog where you will be asked to choose a
printer. This can also be accomplished by dragging and dropping a message to a Windows
printer object.

Print (Default) - This option immediately prints the current message to the default printer.

Close - This option closes the New Message Window.

Compose Window Topics: main menu , button bar , addressing pane , message editor , attachment pane ,
status bar



Compose Window Menu - Edit

Edit - This menu holds all of the standard editing control for the PMMail built-in editor.

Undo - This undoes the last action performed. If Undo is selected twice in a row, it has the same
effect as if Undo was never used.

Cut - Cut deletes the selected text from the edit region to the Windows system wide clipboard.
You can paste it within PMMail or another application that allows for pasting into user input
controls.

Copy - Copies the selected text from the edit region and copies it to the Windows system wide
clipboard. You can paste it within PMMail or any other application that allows for pasting into
user input controls.

Paste - This inserts the contents of the Windows system wide clipboard at the current cursor
position.

Delete - Removes the selected text from the edit region. The removed text is not copied to the
Windows system wide clipboard, or any clipboard.

Select All - This selects all of the text within the edit region.

Compose Window Topics: main menu , button bar , addressing pane , message editor , attachment pane ,
status bar



Compose Window Menu - Attachments

Attachments - All of the attachment options can be reached from within this menu.

Attachment Type - You can select the encoding method for this message. PMMail 2000 will
encode in MIME (BASE64), UUEncode, and BinHex encoding algorithms.

Attach File - If this is chosen, an standard "File Open" dialog will appear. Navigate through your
hard drive and select the file you want to attach. Then, click the "OK" button. Alternatively, a
file's icon can be dragged and dropped to the File Attachment region (to the left of the edit region)
in the Window.

Include File - Text files can be inserted into the text of the message with this menu choice. The
file you want to include is found is chosen on your hard drive with the standard Windows "File
Open" dialog. The text is inserted at the cursor position in the edit region.

Remove Selected Attachment - Select the attachment icon you want to delete from this
message and choose this to remove the attachment.

Compose Window Topics: main menu , button bar , addressing pane , message editor , attachment pane ,
status bar



Compose Window Menu - Options

Options - This menu allows you to choose several attributes of the outgoing message such as priority
and word wrapping.

Priority - You can make this a high, normal, or low priority message.

Security - This menu option is available in PMMail 2000 Professional. You can choose to Encrypt
the Message, Sign the message with your public key, Include your public key, and Include your
public key fingerprint.

Word Wrap - You can choose one of three types of word wrapping: No word wrapping,
WYSIWYG, or reflowing the message at send time.

Return Receipt - If this option is checked on, you will be sent an email if and when your message
is delivered to its recipient.

Compose Window Topics: main menu , button bar , addressing pane , message editor , attachment pane ,
status bar



Compose Window Menu - Signature

Signature - Either choose one of the signatures to append to the end of this message, or to create a new
signature.

Create New Signature - This will take you to the account’s Signature settings page.

Compose Window Topics: main menu , button bar , addressing pane , message editor , attachment pane ,
status bar



Compose Window Menu - Tools

Tools - PMMail 2000 offers several tools to the user to help create an e-mail

Address Book - This opens the address book so you can drag and drop addresses into the
addressing portions of the New Message Window.

Spell Checking - This begins the process to check the spelling in the e-mail.

Compose Window Topics: main menu , button bar , addressing pane , message editor , attachment pane ,
status bar



Compose Window Menu - Window

Window - This has all of the options for dealing with the placement and contents of the window.

Save Window Position - Once this is chosen, PMMail will immediately memorize the current
window position and size of the Address Book Window. All subsequent times the Address Book
is opened, it will appear in the same place, until it is moved and this choice taken from the menu
again.

Compose Window Topics: main menu , button bar , addressing pane , message editor , attachment pane ,
status bar



Compose Window Menu - Help

Help - You can reach this help from this menu choice. You can get help on a variety of topics:
PMMail 2000 Help - This selection brings up the online help for the Compose window.
Help Topics - Shows the table of contents for the Online Help

Keyboard - This brings up the help panel that describes all of the keyboard shortcuts for this
window.

How To Use Help - This option brings up the online help topics that describe how to use the
Windows Help System.

Compose Window Topics: main menu , button bar , addressing pane , message editor , attachment pane ,
status bar



The PMMail Compose Window Button Bar

The button bar contains, from left to right, the following menu shortcuts:
> Message -> Send

7= Message -> Save

*5} Message -> External Editor
%5 Message -> Print

# Edit -> Cut

%5 Edit -> Copy

& Edit -> Paste

' Attachments -> Attach File
=} Attachments -> Include File
- Cycle through priority

- Cycle through Word wrap types
Q.U Cycle through signatures

"V Tools -> Spell Check

%5 Tools -> Address Book

%5 Help -> Help on New Message Window

Compose Window Topics: main menu , addressing pane , message editor , attachment pane , status bar




The Compose Window Addressing Pane

Directly below the button bar in the Compose Window, you will see the PMMail Addressing Pane. In
this pane, you will enter all of the important information contained in the header of the e-mail. The size of
this pane can be changed by grabbing the split bar directly below the subject text and dragging it up or
down. You should notice that the size of the addressing list boxes changes. To see more addresses
without having to scroll, simply pull down on this resize bar, and to see less of the header information, and
more of the message text, raise the bar up.

The first field in the addressing pane is the “To:” field. There are several ways to enter
addresses into this field. First, you can type them into the entry field next to the text “To:”. Then, click
the arrow button located next to this entry field. The address will drop down into the list box below the
entry field, allowing you to type other e-mail addresses and enter them into the “To” list box.

Alternatively, you can enter address book aliases, address book groups, or names of address books. As
well, you can drag an address from the address book to the To: field listbox. Finally, you can use the
Right Mouse Button in the entry field to bring up the address book entries in a menu format, and choose a
name, group, or book from this menu

Next to this is a similar control labeled “CC” This is used to address the e-mail to everyone who
you want to receive a Carbon Copy of the e-mail. Carbon copying is generally used to tell someone to
take note of the e-mail, but no real action or reply is needed, unless explicitly stated in the e-mail (NOTE:
this is not a fixed standard, but rather a guide that suggests when to use To and when to use CC.)

The only difference between this control and the “To:” field addressing scheme, is that the text
“CC:” is actually a state button. You can click it, and the text turns to “BCC:”. You can now use this to
enter addresses that you with to receive a Blind Carbon Copy of the message. If you Blind Carbon Copy
someone, they will receive the e-mail, but no one else will know that they got a copy (i.e. their e-mail
address will not appear in the To: or CC: fields of the message when it is read by a receiver.)

Finally, at the bottom of this pane, you will see the “Subject:” entry for of the e-mail. Enter the
subject of the e-mail in this entry field. If you reply to an e-mail, the subject will be copied, and the
abbreviation “Re:” will be placed in front of the subject. As stated before, below this is the resize bar for
changing the size of the header pane. If you resize the header, and want the new size to be the default
size for every PMMail Read Window, you can select Window -> Save Window Position.

Compose Window Topics: main menu , button bar , message editor , attachment pane , status bar



The Compose Window Message Body Editor

NOTE: There are two features that can be used on text selections. The first one is to reply to a
message and only quote specific text: to do this, select the text to quote, and then choose to reply (or
reply to all) to the message. The second is the Right Mouse Click popup menu for selected text. If text is
selected, PMMail 2000 will extract and display all e-mail addresses and URL Web Addresses in that text.
You can select to either send an e-mail or place the e-mail address in an Address Book. You can also
have your default web browser open and go to the URL(s) that PMMail has extracted.

Compose Window Topics: main menu , button bar , addressing pane , attachment pane , status bar



The Compose Window Attachments Pane

The attachments area is the area to which attachments can be dragged and dropped and in
which file icons will be placed when they are attached to an e-mail. A Right Mouse Button click will also
trigger menu in this pane. It will pop up with the choices to Attach a new attachment or remove the
attachment that you right clicked on (if there was one.)

Compose Window Topics: main menu , button bar , addressing pane , message editor , status bar



The Compose Window Status Bar

Running along the bottom of the New Message Window is the status bar. The status bar

contains information about options and the fly over help for the button bar. The fields of the status bar
are (from left to right):

Welcome Message

Word Wrap Type (set in Options -> Word Wrap menu)

Signature Being Used (Set with Signatures menu)

New Message Priority (Set with Options -> priority menu)
Attachment Type (Set with Attachments -> Attachments type menu)

Compose Window Topics: main menu , button bar , addressing pane , message editor , attachment pane



The PMMail Remote Control Window

The Remote Control will allow you to see pertinent information about the e-mail waiting to be
fetched from the mail server. You can also use the Remote Control to selectively download certain e-
mail messages, or delete them without having to download them. This tool is particularly useful if you
choose to leave your mail on the server or to leave large email messages on the server to download at a
later time (both in the Account Properties, Receive page.)

The remote control window consists of four main parts. Click on one of them to view information
on it:

The Main Menu
The Button Bar

The Message List
The Status Bar



The Remote Control Window Main Menu

The remote control, like the Main Window, has both a button bar and menu bar. The menu bar
consist of three main menus and several second level menus. The menus are:

Message- This menu has all of the actions to be taken on messages that are on the server,
waiting to be downloaded.

Window - This has all of the functional choices of the window.

Help - You can reach this help from this menu choice. You can get help on
a variety of topics:

Remote Control Topics: button bar , message list , status bar



The Remote Control Window Main Menu - Message

Message- This menu has all of the actions to be taken on messages that are on the server, waiting to be
downloaded.

Refresh - This refreshes the list of messages that are on the server.
Transfer Mail - Choosing this options downloads every e-mail on the list that has been tagged to
be downloaded. Every e-mail on the listed tagged to be deleted is removed from the server. This

is just like a normal fetch, except that only those specific messages that you want, get fetched.

Mark To Retrieve Message - This tags the currently selected message so that it gets transferred
when you choose to Transfer Mail.

Mark To Retrieve Copy of Message - This tags the e-mail to be downloaded, except that only a
copy of it is retrieved. The message will remain on the server.

Mark To Delete Message - This tags the currently selected e-mail as "to be deleted" whenever
the transfer list operation is performed. These e-mails are deleted from the server, and are never
downloaded first.

Exit - leave the Remote Control.

Remote Control Topics: main menu , button bar , message list , status bar



The Remote Control Window Main Menu - Window

Window - This has all of the functional choices of the window.
Save Window Position - Once this is chosen, PMMail will immediately memorize the current
window position and size of the Remote Control. All subsequent times the RC is opened, it will
appear in the same place, until it is moved and this choice taken from the menu again.

Remote Control Topics: main menu , button bar , message list , status bar



The Remote Control Window Main Menu - Help

Help - You can reach this help from this menu choice. You can get help on a variety of topics:
PMMail 2000 Help - This selection brings up the online help for the Remote Control window.
Help Topics - Shows the table of contents for the Online Help

Keyboard - This brings up the help panel that describes all of the keyboard shortcuts for this
window.

How To Use Help - This option brings up the online help topics that describe how to use the
Windows Help System.

Remote Control Topics: main menu , button bar , message list , status bar



The PMMail Remote Control Window Button Bar

There is also a button bar that will help you choose menu items more frequently. These buttons are:
J'l =

= Message -> Refresh List
%5 Message -> Transfer List
-+ .

Message -> Mark to Retrieve message

- .

=4 Message -> Mark to Retrieve a copy of the message
%5 Message -> Mark to Delete

%5} Help -> Help on Remote Control

Remote Control Topics: main menu , message list , status bar



The Remote Control Window Message List

The message region has all of the information that you have specified to be displayed about each
message. To change what is displayed in this region, edit the PMMail Global Settings, in PMMail ->
Settings. The information layout of this pane mimics that of the way the user has set up the main window
message list.

Each row of information in the message region represents a message. You can set up (via
PMMail->Settings->Message List) what information will be displayed for each e-mail. There are two
columns that have icons instead of textual information. The Attachment column will be empty for e-mails
that do not contain any attachments, or will have the same icon that appears at the top of this column for
those e-mails which contain an embedded attachment.Also, the Read Status has several states. Any
unread message will have an envelope in that column. This envelope can be one of three colors, red,
yellow, or blue, each representing a different priority of the message. Red is for high priority, yellow
signifies normal priority, and blue signifies low priority. If a colored dot appears, the message has a
priority other then normal, and has been read. A curved left-pointing blue arrow in this column implies
that the message has been replied to.

Remote Control Topics: main menu , button bar , status bar



The PMMail Remote Control Window Status Bar

Across the bottom, as in the Main Window, there is a status bar which contains the transfer status
to indicate any network error and all transfer progress.

Remote Control Topics: main menu , button bar , message list



The PMMail Address Book Window

The PMMail address book is a database of email addresses. You can make separate mailing
lists, or "books" and mail to everyone in that "book". You can also use an Alias you set up in the Address
book instead of the user's e-mail address in any of the recipient fields of an outgoing message.

The Address book main window looks like the Main Window with the Menu bar across the top,
and the button bar underneath it. Most of the Address Book Window is taken up with a region that is
vertically split separating the list of books from the list of users in each book. To see everyone in a book,
you just double-click or "open" a book in the left hand list, and the list in the right hand part will change to
display the users in that book.

To see information on either the menus or the buttons, please select from the following list:

The Main Menu
The Button Bar



The Address Manager Window Main Menu

The menu bar has the following choices:
Book - The Book menu has all of the choices for creating, editing, and deleting a book.

Address - This menu contains all of the choices necessary to create, delete, and manipulate
Address Book entries.

Mail - These choices allow for a new e-mail to be started from within the address book.

Tools - The tools menu has options for searching, importing, and exporting your address book.
Window - This has all of the functional choices of the window

Help - You can reach this help from this menu choice. You can get help on a variety of topics:

Address Manager Topics: button bar



The Address Manager Window Main Menu -Book

Book - The Book menu has all of the choices for creating, editing, and deleting a book. These choices
are:

New Address Book - This creates a new address book. When you are finished filling in the
New Address Book dialog, you will see the new book appear in the list on the left-hand side of the
window.

Delete Address Book - This deletes the currently active Address Book and all of the Address
Book Entries that are currently inside of it.

Properties - This opens the New Address Book dialog with all of the settings for the currently
selected address book already in all of the blanks. You can change any of the attributes of the
address book

Close - Once this is chosen, the Address book manager is closed.

Address Manager Topics: main menu , button bar



The Address Manager Window Main Menu - Address

Address - This menu contains all of the choices necessary to create, delete, and manipulate Address
Book entries.

New Address - This choice brings up the New Address dialog that must be filled in with all of the
information for the new user added to the Address Book.

New Group - This creates a new group list. When you are finished filling in the group list
settings dialog, you will see the new group appear in the address book, along with the addresses
in the currently selected address book.

Move Address - The Move command moves an address from one book to another. This helps
set up the books as mailing lists, and can help categorize the address into meaningful groups.
This can also be accomplished by dragging and dropping an address onto a different address
book.

Copy Address- Copying an address makes the same address appear in multiple address books.
If, for some reason, an address is mailed to twice, only one copy of the e-mail is actual sent to the
user. Copying helps to create better mailing lists categorized with different books.

Create Address Shortcut - You will first be asked in which book the shortcut is to be created.
You cannot create the shortcut in the same book as the original address. A shortcut is merely a
pointer back to the original address entry. All data is shared. If you change the information in
one place, all shortcuts will be updated with the same information.

Delete Address- This removes the currently selected address(es) from the currently open
address book. Note: If the address appears in multiple address books, only the copy of the
address that is currently selected in the currently opened book is deleted.

Print - This will print either the selected address(es) or every member of the address book, if no
addresses are selected. You will be presented with the standard print dialog where you have the
option of choosing one of two different print styles. First is the quick spreadsheet which lists
Alias, Name, E-mail Address, home phone, and work phone number. This is perfect for a quick
list of your contact, or for company-wide distribution. The second option (the "Verbose" option)
prints every piece of information you have entered for each person, one person per page. This
is great if you are making a phone directory, or a contact sheet for people. Names are printed in
the bottom corner for easy

categorization and quick finding in a notebook or binder. Once the pages are printed, hey are
completely ready to be bound for distribution or personal use.

Properties - this menu choice opens the New Address Dialog with all of the settings already filled
in for the currently selected address. These settings can be changed, and then saved. Note:
If the address appears in multiple address books, all copies of the address book entry will have
the changes saved to them.

Address Manager Topics: main menu , button bar



The Address Manager Window Main Menu - Mail

Mail - These choices allow for a new e-mail to be started from within the address book.

Mail Selected Addresses - This option creates a new message that is "To" all of the address
selected in the address book. This can also be accomplished by dragging and dropping the
selected user(s) into the To, Cc, or BCC fields of a new message.

Mail Selected Book - This option creates a new e-mail that is "To" every address in the currently
selected address book. This can also be accomplished by dragging and dropping the Address
Book into the To, Cc, or BCC fields of a new message.

Address Manager Topics: main menu , button bar



The Address Manager Window Main Menu -Tools

Tools - In this menu you will find different tools/utilities to help use, distribute, and maintain your address
book.

Search Addresses - This will open up the Address Book Search Utility. It is quite similar to the
Message Search utility in the main PMMail window.

Directory Services - This will allow you to define the LDAP servers that PMMail will be able to
connect to when performing an LDAP search from within the Search Address facility.

Export - This will export your address book in PMMail's_Comma Separated Address Book
Format.. This format can be read by most spreadsheet applications without any modification.

Import - This will import a Comma Separated Address Book Format into PMMail's address book.
This format and can be created by most spreadsheet applications from a list of address
information without any modification.

Address Manager Topics: main menu , button bar



The Address Manager Window Main Menu - Window

Window - This has all of the functional choices of the window

Save Window Position - Once this is chosen, PMMail will immediately memorize the current
window position and size of the Address Book Window. All subsequent times the Address Book
is opened, it will appear in the same place, until it is moved and this choice taken from the menu
again.

Address Manager Topics: main menu , button bar



The Address Manager Window Main Menu - Help

Help - You can reach this help from this menu choice. You can get help on a variety of topics:
PMMail 2000 Help - This selection brings up the online help for the Address Book window.
Help Topics - Shows the table of contents for the Online Help

Keyboard - This brings up the help panel that describes all of the keyboard shortcuts for this
window.

How To Use Help - This option brings up the online help topics that describe how to use the
Windows Help System.

Address Manager Topics: main menu , button bar



The Address Manager Button Bar

There is also a button bar that will help you choose menu items more frequently. The icons on the button
bar have the following functions:

¥ Book -> New Address Book
£ Address -> New Address
% Address -> New Group
"® Address -> Move Address
r@ Address -> Copy Address
£< Address -> Delete
%1 Mail -> To Selected Book
£21 Mail -> To Selected User(s)

%5 Help -> Help on Address Book

Address Manager Topics: main menu



PMMail Properties - General

Automatically Complete E-Mail Addresses - This option will turn on PMMail’s powerful auto-completion
feature. This feature will automatically complete an e-mail address that you begin to type into one of the
three addressing filed (To, CC, BCC). The addresses are completed using the Most Recently Used List
and your address books.

Minimize To Tray - If this is checked, when the user minimizes the program, you will need to click on the
tray object for PMMail to bring it back up. A button will not appear in the task list for this program when it
is minimized.

Check To See If PMMail 2000 is your default mailer - If this option is checked, then when PMMail is
first opened, it will see if it is setup as the system wide default mailer for other programs to hook into. If it
is not, you will be prompted if you want to make it your system wide default mailer.

Use Preview Pane - If this option is checked then a read-window-like pane will open under the message
list and will contain the message body of the currently selected message. If you select to mark
messages as read after N seconds, then if a message is viewed in the preview pane for a specific
amount of time (that you specify) it will be marked as read to indicate that you have viewed the message.

Create a new web browser window when launching URLSs - If this option is checked then PMMail will
not use your currently opened web browser session to navigate to the URL, but will instead open a new
web browser window and navigate to the URL.

Default Character Set - This setting will be used to stamp your outgoing e-mail with the Charset in which
you typed it. This way, the receiver will be able to properly display your message if you use characters
above character 127 in the Charset.

Encoding Format - Choose QP Encoding if you are sending your e-mail over Internet servers that cannot
handle 8bit (only 7bit) defined characters. If you are not sure what to use, this should be the default.
Only choose 8bit if you are sure all of your receivers will get your e-mail in its full 8bit glory, converted first
form ASCII to the ISO Internet Charset.

Do Not Perform Charset Translation - Check this option if you want NO preprocessing done on your
characters. If this is turned on, your message will be sent out exactly as you typed it. Be warned that
those in other countries, or those with any sort of different locale configurations that differ from yours may
not properly see the message as you intended.

PMMail Property Pages: Message List ,Print Setup, Fonts , User Hooks , Security




PMMail Properties - Message List

This page allows you to configure what information is to be displayed in the message list region of
the PMMail main Windows. By simply highlighting a field, you can either have it shown or not shown by
simply clicking a button.

To show a field that is in the "Fields Not Shown" list, simply click field you want to show in the list.
When it is highlighted, click the "Show ->" button to move it to the "Fields Shown" list. To move a header
item to the "Fields Not Shown" select the field from the "Fields Shown" list, and click the "<- Don't Show"
button.

The position of the fields that you want to show can be changed. By highlighting and clicking the
"Up" and "Down" buttons under the list, you can change their order in the list. The items listed from top
to button are displayed from left to right in the Main Window.

PMMail Property Pages: General , Print Setup , Fonts , User Hooks , Security




PMMail Properties - Print Setup

This group of controls allows you to customize PMMail's mail printing output. You can use this to
completely customize the way your printed e-mail will look coming off the printer. You can customize
what information is printed, what color the information should be, where the information should be, etc.

The settings are split up into 3 main sections: On the top is the printout header, directly
underneath is the message header information, and then down at the bottom is a printout footer.

The header and footers are setup exactly the same. They are the mini 3x3 tables of entry fields
at the top and bottom of this settings notebook page. These entry fields represent the three line header
and footer, each line has a left, middle, and right information column. Text in the left column is left justified,
text in the middle column is centered, and text in the right column is right justified. The header and footer
are sized appropriately to hold just the information you requested.

In each field, you can type either static text, or use any of the predefined variables as defined in
the Table of Predefined Variables that have a "P" in the "Applies To" column.

The long entry field in the middle of the notebook page is where you define which of the e-mail
header lines get printed. Each header line that you want printed gets printed one per line, and is printed
as it appears in the message list or is pulled directly from the header of the message. Simply type the
headerlines you want to be printed, one right after the other, separated by a colon (:). For example, if
you want each printout to include the subject and the date, it would be:

Subject:.Date:
Finally, you have two options for each of the three regions. You can draw a border around each

region, as well as defining on what pages (All, First, or First and Last) you want the region to be printed
on.

PMMail Property Pages: General , Message List , Fonts, User Hooks , Security




PMMail Properties - Fonts

These settings allow you to set the default font face and size for a particular region of the read/compose
windows and the main PMMail windows. The particular regions are:

Region #1: The Read/Compose Header Pane - This is the region along the top of the read and
compose windows. The fields this effects are From, To, Date, CC, BCC, and the Subject. In both the
read and compose windows, all text (static text and user input text) will use this font.

Region #2: The Message Body/Preview Pane - This is the font that will be used as the default font for
composing and viewing messages. This is also the default font that is used (if no other font information
is given from the sender) for the preview pane in the main window.

Region #3: The Attachment Pane - This is the pane that runs along the bottom of the Read/Compose
windows. The font you are setting here is for the text below the attachment icons (the name of the
attachment.)

Region #4: PMMail Tree Views - Both tree views (in the main menu, the folder/account tree view, and
the address book list in the address book manager) can have their font changed. This effects all text in
these views.

Region #5: Message/Address list - The font for the message list in the main windows and the remote
control, as well as the address list in the address book.

PMMail Property Pages: General , Message List , Print Setup , User Hooks , Security




PMMail Properties - User Hooks

PMMail has provided three hooks to the user. The user can specify a program or script
(command batch file) to run upon application start-up (opening) and application shutdown (closing) as
well as the default program to run when dealing with an attachment with no program association.

Type in the script name of the program or script to run when opening or closing the program in
the space next to the "Program To Run" text under the appropriate heading. To enable this program,
click in the box next to the appropriate header name. To disable it, click on the check mark in the box
next to the header.

PMMail Property Pages: General , Message List , Print Setup, Fonts , Security




PMMail Properties - Security

To use PGP in PMMail 2000 Professional, you need to point PMMail to three very important files. These
files are described below:

Default Public Keyring - This file is the file where you store all of your public keys that you collect using
PGP. Type in the full path and filename of the file you want to use as your public keyring file, or click the
Browse button to manually search your hard drive for the file.

Default Private Keyring - This file is the file where you store all of the private (secret) keys that you
create for your user IDs using PGP. Type in the full path and filename of the file you want to use as your
public keyring file, or click the Browse button to manually search your hard drive for the file.

Default random seed file - This file is where PGP obtains its random number generator’s seed. Type in
the full path and filename of the file you want to use as your public keyring file, or click the Browse button
to manually search your hard drive for the file.

PMMail Property Pages: General , Message List , Print Setup, Fonts , User Hooks




Account Properties - General

Description - This will be the exact text that appears in the account / folders tree pane of the PMMail
Main Window.

From E-mail Address - Enter your full Internet e-mail address in this space.
Example: cochese@yvirtual.reality.com

From Real Name - Enter your full real name or preferred nickname here.
Example: Frances Steven Oren Cochese, lll.

Reply -To Information - If you want e-mail that is a reply to your e-mails to go to a different account with a
different real name, enter that information here. Otherwise, make sure that this information is the same
as the "From Information".
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Account Properties - Receive

NOTE: if you fetch your mail over a TCP/IP network or the Internet from a remote mail server,
most likely you will need to use POP.

If you want this account to Receive e-mail using the SMTP Protocol, click on the circle next to the text
SMTP and type in the full hard drive path to the SMTP Inbox. Alternatively, If you want this account to
Receive e-mail using the Post Office Protocol (POP), click on the circle next to POP and type in the
following information:

POP Server - This is the machine name of the e-mail server on your network.

Port - This is the port that you need to connect to download your e-mail. Unless you know the port to be
different, it should be the standard POP port of 110.

User ID - This is your e-mail user ID (or Login ID.) Make sure all proper punctuation and capitalization is
observed.

Password - Type in your e-mail password (or Login Password.) Do not worry, this password will not be
displayed on the screen, or anywhere else.

Authenticate Using - You can choose one of three authentication methods. You must have this setting
correspond to the authentication method that your Mail Server is using. The most common is plain POP
Passwords, however some servers require either APOP (Authenticated Post Office Protocol) or RPA
(Remote Password Authentication.) If you are not sure what to use, contact your Internet Service
Provider.

If you are using PMMail to fetch your CompuServe Mail, then you will want to use the RPA Authentication
option. Use the APOP authentication method if your ISP instructs you to do so.

If you would like to leave messages larger then a certain size on the mail server, check the box next
to the "Ignore Messages..." text and specify the size you want to leave on the server with the up/down
arrows, or by typing in the value.

If you would like to leave all messages on the server, and only download copies of the messages
during a "fetch", check this option. The Reset button will make PMMail fetch all e-mail that is on the
server during the next fetch cycle (all mail will still remain in tact on the mail server.)

To open PMMail's Remote Control Window and perform a manual customized fetch upon every
fetch attempt, check the "Receive Using Remote Control" option.

For those using any form of message storing on the email server (i.e. leave on server), we have provided
two distinct methods of checking your server for new messages. Blueprint Software Works’s Quick
Interrogation is the default method. This method can highly reduce your online time by using an
estimating algorithm to quickly find new messages. However, because it employs several features of a
POP server that are found on most, but not all servers, we have also provided a Full Interrogation
method. If you feel that PMMail may be missing some e-mails that are up on your server, either by
fetching or using the remote control, turn off the Quick Interrogation for more accurate results.

Finally, to enable this account to automatically fetch after a given duration of time, check the
"Check For New Mail..." option, and set the number of seconds that the account should wait before
attempting to refetch the e-mail. Note that this account need not be active for this option to be operating
in the background. All accounts with this option enabled will work throughout the duration of PMMail
being run.



Account Property Pages: General , Send , Security , Preferences , Prompts , Spell Checking , Editor ,
Signatures , Canned Replies , Filters , Hooks




Account Properties - Send

SMTP - For SMTP sending, make sure the circle next to the SMTP text is filled in by clicking in the circle.
Then, fill in the machine name of your networks mail server and type in the port number. If you are
unsure, use the default port of 25.

POP - To send using the POP Protocol, Type in the POP server, port, user ID and Password just like on
the Receive page.

Authenticate Using (POP) - You can choose one of three authentication methods. You must have this
setting correspond to the authentication method that your Mail Server is using. The most common is
plain POP Passwords, however some servers require either APOP or RPA. If you are not sure what to
use, contact your Internet Service Provider.

Most ISPs and mail servers only support SMTP sending of e-mail. If you get an error, and you are
sending via POP, try to send to the same server via SMTP.

Wrap Messages -To enable the Word Wrapping options, click in the box to the left of the "Wrap
Message" text so the check mark appears. Then, either choose to wrap after a user specified amount of
characters, or WYSIWYG wrapping. WYSIWYG wrapping uses the width of the editor to determine
where the text will get wrapped.

If you wish PMMail to keep a copy of every e-mail you send in the Sent folder, check the “Save copy of
outgoing mail” option. If you wish PMMail to try to send any e-mail that is queued for sending in the
Outbox after every send, check the “Send after fetch” option.

In order to force PMMail to queue all outgoing messages until you use the Send Queued Messages
command to send them, make sure the box next to Send Immediately is NOT checked. If this box is
checked, then PMMail will attempt to make a network connection to the server everytime you send a
message.

To set the default Attachment encoding method, drop the list of Attachment methods and choose one of
the following:

MIME - MIME uses BASEG64 en/decoding. This is a popular newer format for sending to any e-
mail client.

UUEncode - This is an older UNIX encoding technique that many e-mail clients support.

BinHex - BinHex encoding is like BASE6G4, but has become a standard encoding method for
Macintosh e-mail clients. Very few e-mail clients support this type of encoding.
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Account Properties - Security

In the list at the top, you can choose which key (if one or more exist) to perform the following actions on:

If you do not yet have a security key created, the test (None) will appear as the only entry in the list. To
create your first key, simply select the New button. Use can also use this button If you want to create
more keys.

Change Passphrase: |If you would like to change your passphrase, pressing this button will bring up a
dialog in which you can change your passphrase. A good passphrase is typically more than 8
characters, with numbers and spaces (A complete sentence is very secure and easy to remember.)

Add User ID: Use this button to associate an e-mail address with the key. Setting up this association
will tell PMMail which key to use when you use the e-mail security features (sending encrypted mail,
decrypting messages, etc.) in a particular account.

Remember my passphrase for the remainder of the session: After being prompted for your
passphrase once, it will be stored in memory until PMMail is closed. This option is usually secure unless
many people have access to your machine who may be able to use memory inspection tools to find the
passphrase in memory.

Sign every outgoing message: When checked, PMMail will digitally sign your outgoing messages.
This digital signature insures other people that the message actually came from you.

Include public key on every outgoing message: When this option is turned on, PMMail will include
your public key at the end of every message you send. Sending your public key to someone allows them
to add this key to their keyring. Once they have your key in their keyring, they can then verify signed
messages from you, as well as send you encrypted messages.

Include public key fingerprint on every outgoing message: With this option turned on, your public
key fingerprint is included at the end of all your messages.

Warn about security issues: When this option is enabled, PMMail will notify you of any possible
security risks that are present.
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Account Properties - Preferences

Message - To always view the full header of an e-mail when reading the e-mail, enable the "View Full
Header..." option. PMMail will allow you to set the default reply quoting characters. Check this box if
you do not want the body of the message quoted in replies by default. Furthermore, you can define what
string is placed in front of each line of text that you are “quoting”. If you do want the body quoted, leave
this unchecked.

If you have Preserve Original Message Formatting When Replying checked, then when you
reply to a message with rich character formatting (and HTML message, for example) it will retain its rich
formatting in the reply. Leave this unchecked to always reply using plain text.

The Close Read Window When Replying option will open the compose window for the reply but
also close the original message that you are replying to (if it was opened.) This is a handy option to help
keep you desktop a little less cluttered with open windows.

You can also always view the attachment pane of outgoing messages while you are composing
them, if so, check the “View the attachment area of an outgoing message by default” option.

New Mail Notification - Upon receiving new mail, you can choose to have PMMail audibly notify you with
either a speaker chime and/or by playing the sampled sound file that is specified in the space provided.

Security - The account can be locked with a password. If enabling this option, remember to type in a
password in the space after the option's text. Remember this password, it will not be displayed and there
is no way to retrieve it This option will prevent someone from opening the settings of the account, or
expanding the account to see the folders without typing in your password.

Startup Actions - Upon PMMail's start-up, the account can be set to Open the account (display the top
level folders of the account), Fetch your Mail, and Send all queued messages for that account. To
enable any of these, simply make sure these items are checked by clicking on them.

You can also have PMMail automatically remove trash that is a given number of days old. If you enter a
zero (0) for this amount, the trash will be emptied every time the program is shutdown.
This will permanently delete those messages that have be removed from the trash

WARNING: If you use the “Empty Trash After n Days” setting under PMMail 2000, and you
share your data with the OS/2 version of PMMail you need to read this warning. This option is
translated to the "Empty trash on shutdown" option under PMMail for OS/2. If you prefer to
manually empty your trash under OS/2, you will have to turn this option off.

Finally, you can have PMMail perform what are known as "True Deletes".
When this option is checked, the messages are not moved into the trash folder upon deleting them,
instead they are removed immediately from your hard drive.
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Account Properties - Prompts

This page consists of several check boxes that are used to enable or disable PMMail's mistake
prevention. When certain critical actions are performed (such as deleting a message) and this feature is
enabled, a dialog will appear asking you to verify the action.

You can have PMMail verify the following actions:
Program Close - When you want to exit the program, you must click "OK" in the verify dialog.

Close of Outgoing Message - If you try to close the compose window before you issue a send,
you must verify that you actually want to cancel this massage.

Account deletion - To remove this account, you must verify that you really want to delete it
before PMMail will let you.

Folder deletion - To remove a folder, you must verify this.

Message Deletion - Before PMMail will allow you to delete a message, you must verify this
action.

Attachment Decode When Duplicate File Exists - With this verification turned on, PMMail will
prompt you if a file already exists with the same name as the attachment. If you select YES, the
file will be overwritten, otherwise, no decoding is performed. If you do not have this verification
turned on, PMMail will not perform any decoding if it finds that a file with the same name already
exists.



Account Properties - Spell Check

Check all outgoing - Selecting this option causes your messages to be automatically spell checked
when you hit the 'send' button.

Skip quoted text - Selecting this option causes text that you have quoted in your message (from the
message you are replying to), to be exempted from spell checking.

Skip words in all caps - This option will cause words that are all in caps, such as "USENET" and
“SMTP”, not to be spell checked.

Skip words containing numbers - Checking this option will cause words containing numbers, like
"20th", to be exempted from spell checking.

Setting a custom skip list - Use this area to enter partial words that you wish to be used to disqualify
words for spell checking.
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Account Properties - Editor

To use PMMail's built-in editor, you must make sure that this is the option chosen. Otherwise, an
external editor will be used.

To Use an external editor, you must click the circle next to the text and provide PMMail with the following
information about the external editor:

Editor - The full program name of the editor (example NOTEPAD.EXE for NOTEPAD.)

Arguments - The command line arguments and switches. Place a %s where the name of the
input file appears in the command line parameters.

Finally, you must choose for which actions (Reading or Composing) the external editor is used.
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Account Properties - Signatures

To use e-mail signatures, PMMail will allow you to set up a small database of signatures that can
be appended onto the end of every e-mail you send. To make a new signature, click the "New" button,
and a small editor will appear. Above it, you must type in a Description of the signature. This will be
used as the identifier for the signature in a number of places. Examples of signature descriptions are
"Fun Sig" or "Professional Sig". After you type in the Description, you can tab to the editor, or click inside
the editor and start typing your signature. You can also Edit or Delete a signature by highlighting its
identifier in the list of Signatures, and clicking Edit or Delete.

To make a signature appear in an e-mail by default, select it from the list, and click the "Set As
Default" button.
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Account Properties - Canned Replies

The next page is the setup for the Canned Replies feature of PMMail. A Canned reply is a
prewritten message that can be stored within PMMail and inserted very quickly into an e-mail. This is

useful when you have to manually answer the same question or provide many people with the same
information.

To use canned replies, PMMail will allow you to set up a small database of canned replies that
can be inserted into any e-mail you send. To make a new canned reply, click the "New" button, and a
small editor will appear. Above it, you must type in a Description of the canned reply. This will be used
as the identifier for the canned reply in a number of places. Examples of canned reply descriptions are
"Directions to my house" or "Registration Information”. After you type in the Description, you can tab to
the editor, or click inside the editor and start typing your canned reply. You can also Edit or Delete a
canned reply by highlighting its identifier in the list of canned replies, and clicking Edit or Delete.

To use a canned reply, simply right mouse click in the editor when composing a message and a
list of canned replies will appear. Simply choose one, and the text will be inserted at the cursor.

Variables in Canned Replies!!! In canned replies we offer the ability to use certain predefined
variables in search strings. So, you can have a template reply that will fill in personalized greetings and
salutations, selectively quote messages, and many many more options. As well, you can use the
variables to access current time and dates, as most importantly, you can finally make a canned reply look

personalized! Click here to see a full list of variables, as well as some do's and dont's about special
characters Actions that you now cannot use in the canned replies without a bit of padding and care.
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Account Properties - Filters

Afilter can be applied to any e-mail in PMMail and automatically to all incoming e-mail. What the
filter does is look for certain test strings in different parts of the message. |If the filter engine finds a
match with one of the filters set up, the action specified for that filter is taken, such as moving the
message to a different folder.

To use filters, PMMail will allow you to set up a small database of filters that can be applied to
every e-mail you receive, send, or already have. To make a new filter, click the "New" button, and a form
will appear.

For more help on how to fill in this form, see the Filter Setup help panel.
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Account Properties - Hooks

Each Account has four built in user program hooks triggered by the networking actions of sending
and receiving. The user can specify a user program to run upon sending a message or receiving a
message, both before and after the networking actions are performed. Once enabled (by clicking the
checkbox next to the program hooks title), these scripts are run every time the action is performed.

These scripts all are run at very specific, but different, times during the fetching and sending
cycle. The Message Send hook is called right before PMMail sends the message to your mail server.
This way, you can use this exit to reformat the actual message file to include any other information you
may want, or to remove any part of the message. The Message receive exit is called right after each
message is pulled down from your mail server. It is called once for every e-mail that you receive in that
fetch cycle.

The Custom Exits are also called at very specific times. The Custom Send Exit is called for
every outgoing e-mail in your Outbox during the sending process. If you have this exit on, then this
program is called in place of PMMail's SMTP or POP sending routines. This program needs to perform
the actual sending functions. The Custom Receive Exit is called right before the network connection is
established with your mail server to receive your e-mail. No matter how much e-mail you receive on that
fetch cycle, it is only called once, right before connection with your mail server.

The programs are each passed one argument, that is the fully qualified path and filename of the
e-mail message which PMMail is currently processing. You must be careful to make sure that your
Programs do not violate any of the RFC rules for the layout of an e-mail (refer to RFC 822, 936, 1521,
and 1522 for more detail.) If they do, there is no guarantee that either you or the receiver will be able to
display them properly.
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Folder Properties - General

Description: This will be the name of the folder in the tree view of folders on the Main Window.

Sort Order: Choose Ascending for a least to greatest ordering of messages within the folder, or
descending for a greatest to least ordering of messages within the folder. This will be the order in which
they are displayed to the right of the account/folder tree.

Sort Priority: Itis up to the user to order the list of sort fields. These sorts will be performed on the
order in which they appear in the list. The field on the top of the list will be the primary sort, and the
second one in the list will be used to break any ties, and any further ties will go to the third, and so on.
To move the ordering of these fields around, click on the one you want to move in the list and repeatedly
click the "Up" or "Down" buttons until the field is in the proper placement.

Finally, two attributes of the Folder Icon must be set. The picture next to the folder name can convey
information about the messages in the folder. If the "...Indicates Unread Mail" option is checked, the
icon will have a green check over it if any unread mail sits in that folder. If the "...Any Mail" option is
checked, then if there is any mail sitting in the folder, a red check mark will appear on top of the folder's
icon.



Address Book Properties - General

First, you must type in the Description of the address book. This will be the name of the address
book in the Address. The only other option is the sorting of the addresses within the dialog. When the
address book is opened, and the aliases are displayed to the right, this sort order determines in what
order the addresses are listed.



Group Properties

This dialog is used to create a new Group List in the currently selected address book. You will notice a
notebook that comes up with one page: Group. The information on these pages should be filled out
with the appropriate information:

Group Name - This is the name of the group. This name will be used as a short description of the group
when you need to choose it out of a list.

Alias - This is an alias you can use when you want to send to this group. The alias is in any addressing
field where you want the recipients of the message to be the members of the group.

Description - A short, one sentence description of why the group exists.

Members - These are the e-mail addresses of each member of the group. As the note below this
addressing window states: you can use address book names, other group lists, or aliases from the
address book along with real e-mail addresses, however, you MUST enter them one line at a time, with
no commas separating member's addresses.



Address Properties - General

E-Mail Address - This must be the full Internet e-mail address.
An example of this would be: cochese@vr.com

Alias - This is the Alias that will be used when referring to this address book entry. Aliases can be
entered as a recipient of an e-mail. The Address Book engine will resolve these Alias references.

An example of an Alias for the above e-mail address example would be simply the name:
cochese.

Real Name - This is the real name of the person whose entry you are adding.
Finally on this page, you will see an option "Add to Right Mouse Click..." If this is enabled, you can right
mouse click in any of the recipient fields in the Compose Window, and a menu will appear with all of the

aliases you have added to this menu.
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Address Properties - Address

The address page is a standard fill-in form for all of the information about where the person lives
and works.

For the Phone/Address group of entry blanks, you can switch between Home and Business
information for viewing or filling in via the pull down menu for the category you want to fill in. It initially
says "Home". Home or Business information can be entered or retrieved.
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Address Properties - Notes

This page contains a small editor that will allow you to type in any notes about the user. Simply
turn to this page and start typing notes about this address or the addressee.
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Address Properties - Security

Created: The date the key was created.

Expires: The date this key expires.

Key size: This is the number of bits used by this public key. The higher the number of bits, the more
secure it is, however, more bits also increase the time required to encrypt or check the signature of a
message.

Key type: The key type-either RSA or Diffie-Hellman/DSS.

Cipher type: The encryption algorithm that the key uses-either CAST, IDEA, or Triple-DES.

Key fingerprint: This is a consistency check for this public key. When someone sends you their public
key, there is a chance it could become corrupted. If they also send you the key fingerprint, you can verify

the key by comparing the supplied fingerprint to the one shown here.

Validity: This field displays the key's validity-Invalid, Marginal, or Complete. A key becomes more valid
the more you trust the people who have signed it.

Trust: Displays your level of trust in the key-Untrusted, Marginal, or Complete. Trust is a measure of
how much you believe the key actually came from the person to whom it says it belongs.

Validity bar: Displays a graphical representation of the key's validity.

Trust slider: Move the slider bar to assign a level of trust to the key. The farther you move the slider to
the right, the more you trust this key. The farther you move the slider to the left, the less you trust this
key. You cannot adjust the trust of an invalid key.

Enabled: Enables the key. A disabled key cannot be used to perform any PGP action.

Sign key: Pressing this button will allow you to sign this public key (or vouch for it) saying "Yes, | believe
this key is from who it says it's from."
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Find Message Tool

PMMail's robust message search facility allows you to perform either very wide or very specific searches
for messages containing certain information. To perform a search, you must fill in the following two
sections:

The first section is the Look In section - You can start the search in as narrow as a low level search, or all
the way at the top, an account. The drop down list has all of the accounts and folders of PMMail. Once
you select a folder or account to search in, you must specify whether you want subfolders to be searched.
To search an entire account, select the account and enable the "Subfolders" option.

The second section is where you define the search criteria this search will attempt to match, when
applied. If your searching criteria can be expressed in two or less items, you can use the
"simple" search template.

To use a "simple" search, you must set at least the first search criterion. In the search selector, choose
the section of the message that you wish to have searched, <Whole Message> (Header lines and Body),
<Header> (just Header lines), <Body> (everything but Header lines), <Attachment Name> (for specific
attachments), or select a specific Header line to search, 'To', 'From’, 'Subject’ or 'Cc'. Fill in the 'For' box
with the specific string you wish to locate with this search.

In the "String" you can now use variables. With these variables, you can test against other parts of the e-
mail (i.e. the from field is equal to the to field), current time and date information, as well as some of your
account information. It is important to note that the introduction of these variables requires the need to
double up all dollar signs ($) used in the search string. This is explained in better detail along with the list
of all of the variables you can use in the :Table of Predefined Variables

For more powerful "simple" searches, you may define a second search expression, as you did the first,
and use the 'And', 'Or', and 'Unless' connector to join the terms. If you are not using a second term, 'No
Connective' should be selected between the two search areas.

For the message to be included in the search results with the 'And' connector used, both search
expressions must match in the message being searched. If the 'Or' connector is used, either search
expression matching will cause the current message to be included in the search results. Using the
'Unless' connector requires the first search condition to match, and the second search expression not to
match, for the current message to be included in the search results.

If you have more than two terms you wish to search for, or if you want to exploit the full power of PMMail
2000 searching, you must use the "complex" template. This gives you a free form area where you will
express your search in Blueprint Software Works's Internet Communication Search Language
(ICSL). ICSL uses Boolean (AND, OR, and NOT) connectors and parenthetical groupings to

allow extremely powerful searches, completely under your control. ICSL is explained in detail in the ICSL
Reference

Once you have filled in all of the information, click "Find". At this point, PMMail's Search Engine will
begin to search the messages in the specified range for the "For Text". If you want the search to Stop,
just click the "Stop" button, it will be enabled only when a search is in progress.

The results of the search appear in the bottom half of the dialog. You can treat this list just the same as
the Message List in the Main Window. To read a message, just double click it from the list.



Find Address Tool

PMMail's robust find facility allows you to perform either very wide or very specific searches for
addresses containing certain information. To perform a search, you must fill in the following information:

Look In - You can start the search in as specific as a single address book, or all the way at the
top, all address books. You can also select to search an LDAP server which will perform an
LDAP search. You can set up other LDAP servers to search in the Directory Services option of
the Tools menu.. The drop down list has all of the address books and LDAP servers defined in
PMMail.

Search - You can choose one of the predefined search fields of the addresses. These range
from the Name of the person to their company or personal information.

For Text - This is the exact text that find will be searching for. Make sure that you are careful
about correct punctuation and capitalization to accurately find the address.

You can also search on up to two search terms, connected by a Boolean operator such as AND,
OR, and Unless. You can then fill in a second set of Search and For fields. This greatly
increases the efficiency and robustness with which you can search the address books or LDAP
servers.

Once you have filled in all of the information, click "Find". At this point, PMMail's Find Engine will
begin to search the messages in the specified range for the "For Text". If you want the Find to Stop, just
click the "Stop" button. This button will be enabled only when a find is in progress. The results of the find
appear in the bottom half of the dialog.



Account Error Log

The Account Error Log is a history of all network errors that have ever been reported for the
account. Occasionally, the status bar in the main window will say to look there for an error. The time
and date have been inserted to make it easier to find errors. These errors usually result from problems
with the network or network setup portion of this account.

The most recent errors will be at the end of the list. This list can be emptied (if it is getting long)
by clicking the "Empty Log" button. This will delete all entries in the error log.

These errors are important for the help staff to diagnose your problem. For more information on
the meaning of one of these errors, please contact your Internet Service Provider, or you companies
network specialist first, and if they cannot help you, then contact PMMail support.



Filter Builder

The Filter Builder is a tool that will help you build a filter. What the Filter Builder does is it looks
at messages you already have for the criteria you want to filter on. So, you first need to select the
messages you want the new filter to act upon.

For example, you receive several messages from a group of people all working on the same
project, and you decide you want all e-mail from a member of the team to go into a special folder in your
account. If there are a lot of people on the team, it would be difficult and sometimes confusing to create
a complex filter to catch all of the names you want the filter to act on. So, you would select all of the
message from team members, and use Filter Builder. The Filter Builder will "rip" the e-mail addresses
out of the messages and build the complex filer (written in ICSL) for you. All you need to is decide what
actions to take on the messages. This is a quick way to begin to categorize an overcrowded Inbox.

So, first you must select the messages the you want the filter to build its information form. This is
usually a sample of an e-mail that you would want the filter to catch.

Second, fill in the Description field. This gives the filter a name, which will appear under the
Account->Properties->Filters dialog. One method is to choose a name that will remind you what the filter
is intended to match, or the action being performed, so it will be easier for you to distinguish filters in your
growing collection, as you find more types of messages you wish to filter.

Next, choose the “connective” method you want to use. If you selected more then one message,
you can AND together all of the keywords you are pulling out, or you can OR them together. If you AND
them together, then an incoming e-mail must include ALL of the keywords to be filter, if you OR them
together, then the e-mail will be filtered if only one of the keywords is found in the message.

Now, choose the field to build the filter from. You have a choice of five common header fields.

The next step, is to define when you want the filter applied. There are four times that filtering is
attempted on messages. An 'Incoming’ filter is applied to every message received, after it has been
downloaded from the server, but before it is deposited in your 'Inbox’ folder. 'Outgoing (Pre-Send)' filtering
is performed on every outgoing message, before it is sent. 'Outgoing (Post-Send)' filtering is applied after
each outgoing message, but before the message is deposited in your 'Sent' folder. 'Manual' filtering is
applied to messages that are selected (highlighted) when the 'Message->Apply Filters' menu option is
selected. You may select any or all of these times for a specific filter to be applied.

NOTE: If the 'Manual' box is not checked, this filter will not be applied to selected messages
when manual filtering is performed.

The last step in defining a filter, is to select the 'Action(s)' to be performed when the search
expressions are met. Up to six consecutive actions can be performed on a message, represented by the
six entries in this section of the template. At each action, there is a choice of many specific actions that
may be performed. When a specific action is selected, if additional information is required to perform
that action, a drop down list box, or entry field will appear to the right of the selected action. (Example: If
the filter is to forward the message, an email address, alias, or address book name will need to be
entered into the list box that will appear to the
right of the 'Forward' action.) If no additional field appears, no further information is required to perform
that action. For more information about what actions are permitted, and how they interact with the filter,
please see the Table of Allowable Actions

It is important to understand, certain actions ('Stop Filter', 'Delete Message' and 'Copy Message')
will prevent subsequent actions from being performed, and will prevent further filters from being applied to
that message. These actions must be the last action applied on a message.



Before clicking 'OK' to save your new filter, check to be sure the 'Enable’ checkbox, in the upper
right corner of the template, is checked. A filter can be saved, but will not be used, if the 'Enabled’
checkbox is not checked.



Signature and Canned Reply Editor

This dialog allows you to edit the text of a signature or canned reply.
The description field allows you to edit the name of the signature or canned reply.

Once you have edited the description and the text of the signature or canned reply, click OK and your
changes will be saved.

It is worth noting that the standard Windows keys for cut, copy and paste will work here.



Spell Checker

When the PMMail Spell Checking tool is active, it occupies the bottom of the Compose Message Window
being spell checked.

It will begin checking at the beginning of the message body, and will stop, highlighting the first word that it
believes is misspelled, offering you a selection of choices for replacement words. At this time, you can
choose any of the following spell checking actions:

Ignore - Ignores this occurrence of the word in question, the spell checker will continue checking the
remaining text.

Change - Changes the highlighted text in the body of the message, with the highlighted choice in the
word replacement list in the left of the spell checking dialog. The word you use to replace the misspelled
word is then run through the spell checker itself before it is inserted.

Add to dictionary - If you are sure the highlighted text is spelled correctly, and wish to have this spelling
accepted in the future, this selection will add the word to your PMMail Custom User Dictionary.

Ignore all - Ignores not only this occurrence, but any further occurrences within your article as well.
Change all - Changes the highlighted text to the choice highlighted in the replacement word list, and will
automatically make that change if it encounters any identical misspellings in the rest of the message
body.

Stop checking - Immediately stops the spell checking process, and proceeds with either sending the
message (if it's an automatic check on sending) or returns you to editing the body of the message.



Find Text

With the find dialog you can type in text to be searched for in the message. You can either have
a case sensitive, or case insensitive search of the message. If the text is found, it will be selected to help
point it out amongst the rest of the message.



Filter Settings

To create a new filter, there is a template dialog that must be filled out. The template consists of
four sections, The filter name, what to filter, when to filter, and the action(s) to take when a filter matches.

First, fill in the Description field. This gives the filter a name, which will appear under the
Account->Properties->Filters dialog. One method is to choose a name that will remind you what the filter
is intended to match, or the action being performed, so it will be easier for you to distinguish filters in your
growing collection, as you find more types of messages you wish to filter.

The second section is where you define the search criteria this filter will attempt to match, when
applied. If your filtering criteria can be expressed in two or less items, you can use the "simple" filter
template.

To use a "simple" filter, you must set at least the first search criterion. In the search selector,
choose the section of the message that you wish to have searched, <Whole Message> (Header lines and
Body), <Header> (just Header lines), <Body> (everything but Header lines), <Attachment Name> (for
specific attachments), or select a specific Header line to search, To', 'From', 'Subject' or 'Cc'. Fill in the
'For' box with the specific string you wish to locate with this filter.

For more powerful "simple" searches, you may define a second search expression, as you did the
first, and use the 'And’, 'Or', and 'Unless' connector to join the terms. If you are not using a second term,
'No Connective' should be selected between the two search areas.

For the filter 'Action’ to be performed, if the 'And' connector is used, both search expressions
must match in the message being filtered. If the 'Or' connector is used, either search expression matching
will cause the 'Action’ to be performed. Using the 'Unless' connector requires the first search condition to
match, and the second search expression not to match, for the 'Action’ to be performed.

If you have more than two terms you wish to filter for, or if you want to exploit the full power of
PMMail filters, you must use the "complex" template. This gives you a free form area where you will
express your filter in Blueprint Software Works's Internet Communication Search Language (ICSL.) ICSL
uses Boolean (AND, OR, and NOT) connectors and parenthetical groupings to allow extremely powerful
filters, completely under your control. ICSL is explained in detail in the ICSL Reference

The next step, is to define when you want the filter applied. There are four times that filtering is
attempted on messages. An 'Incoming’ filter is applied to every message received, after it has been
downloaded from the server, but before it is deposited in your 'Inbox' folder. 'Outgoing (Pre-Send)' filtering
is performed on every outgoing message, before it is sent. 'Outgoing (Post-Send)' filtering is applied after
each outgoing message, but before the message is deposited in your 'Sent' folder. 'Manual' filtering is
applied to messages that are selected (highlighted) when the 'Message->Apply Filters' menu option is
selected. You may select any or all of these times for a specific filter to be applied.

NOTE: If the 'Manual' box is not checked, this filter will not be applied to selected messages
when manual filtering is performed.

The last step in defining a filter, is to select the 'Action(s)' to be performed when the search
expressions are met. Up to six consecutive actions can be performed on a message, represented by the
six entries in this section of the template. At each action, there is a choice of many specific actions that
may be performed. When a specific action is selected, if additional information is required to perform
that action, a drop down list box, or entry field will appear to the right of the selected action. (Example: If
the filter is to forward the message, an email address, alias, or address book name will need to be
entered into the list box that will appear to the
right of the 'Forward' action.) If no additional field appears, no further information is required to perform



that action. For more information about what actions are permitted, and how they interact with the filter,
please see the Table of Allowable Actions

It is important to understand, certain actions ('Stop Filter', 'Delete Message' and 'Copy Message')
will prevent subsequent actions from being performed, and will prevent further filters from being applied.
These actions must be the last action applied on a message.

Before clicking 'OK' to save your new filter, check to be sure the 'Enable’ checkbox, in the upper
right corner of the template, is checked. A filter can be saved, but will not be used, if the 'Enabled'
checkbox is not checked.

Filter Settings , Table of Allowable Actions , ICSL Syntax Reference , ICSL Language Reference , |ICSL
Tips and Examples



Table of Allowable Filter Actions

Blueprint Software Works's new filter system has a rich assortment of actions that can be
performed when a filter is applied. You may choose up to six actions, per filter, to be performed.
Actions can be in any combination, including performing the same action more then once.

Be sure to read the full explanation of the action to make sure you fully understand what
will happen when the filter is applied, and what information you must provide PMMail with to
perform that action. You should also very carefully review when you have selected to apply the
filter (Incoming, Outgoing, Manual) to determine that you will achieve the desired effect, without
unintended consequences. Like any powerful tool, PMMail's Filters, can when improperly
configured or used, do things you may not want.

Actions for both Simple and Complex filters:
No Action - Literally no action is performed.

Set Status - Set the status of the message if it matches the search terms. When you choose
this action, you must choose the status (that will be set) from the drop down list to the right (click
on the down arrow on the rightmost edge of the choices.) The choices are: Unread, Read, and
Replied/Forwarded, the default choice is Unread.

Set Priority - Set the priority of the message if it matches the search terms. When you choose
this action, you must choose the priority (that will be set) from the drop down list to the right (click
on the down arrow on the rightmost edge of the choices.) The choices are: Low, Normal, and
High, the default choice is Normal.

Set Subject - Change the subject of the message if it matches the search terms. When you
choose this action, you must type the new subject in the entry field that will appear to the right of
the action.

Play Sound - Play a sound file if the message matches the search terms. When you choose
this action, you must type in the full path and filename of the file to be played. Type this path and
filename in the entry field that will appear to the right of the action.

Open Message - A PMMail read window with the message that matches the search terms will be
opened upon triggering this filter. No further input is needed.

Print Message - PMMail will print the message that matches the search terms. This message
is printed on the Windows printer you select from the drop down list that will appear next to this
choice. The default printer for this action is the printer which is set up as your Windows default
printer.

Inform User - A dialog will popup whenever this filter finds a message that matches the search
terms. This dialog will inform the user that the filter has been triggered. No further input is
needed.

User Hook (Foreground) - When the filter is applied, this program will be executed in the
foreground. The full path and filename of the program must be entered in the entry field to the
right of the action. The program will be passed one argument, the full path and filename of the
file containing the full message being filtered.

User Hook (Background) - When the filter is applied, this program will be executed in the
background. The full path and filename of the script must be entered in the entry field to the right



of the action. program will be passed one argument, the full path and filename of the file
containing the full message being filtered.

Send Canned Reply - A Canned reply can be send back to the sender of the message when this
filter is applied. If you choose this action, you must choose from a list of your premade canned
replies for the current account from the drop down list to the right (click on the down arrow on the
rightmost edge of the choices.)

Forward Message - A message that triggers a filter with this action will be forwarded to another
person. If you choose this action, you must type the forwarding e-mail address in the entry field
that appears to the right of this action. You can enter an e-mail address, an address book alias,
an address book name, or a grouplist.

Bounce Message - This action bounces the message to another person. You must type the e-
mail address you want the message bounced to in the entry field that appears to the right. You
can enter an e-mail address, an address book alias, an address book name, or a grouplist.

It is important to note that if the message is moved, all further filtering will STOP at that point. No
more filters will be run on the message once all actions of this filter have been performed.

Move Message - This action moves the message to another folder. If this action is chosen, a
listbox will appear to the right. Click on the down arrow on the rightmost edge of the choices. This
list contains all of the folders in the current account.

Copy Message - This action copies the message to another folder. If this action is chosen a
drop down list will appear to the right (click on the down arrow on the rightmost edge of the
choices.) This list contains all of the folders in the current account.

It is important to note that if the message is deleted, all further filtering will STOP at that point. No
more filters will be run on the message once all actions of this filter have been performed.

Delete Message - This action deletes the message. A drop down will appear next to your delete
action. You need to choose what copy of the e-mail to delete. If you do not leave your e-mail
on the server, then you can only delete the local copy. However, if you employ the “leave on
server” feature of PMMail, you can choose to delete the local, remote (copy on the server), or
both copies. This is an effective way to keep unwanted messaged off of the server if you use
leave on server without having to use the remote control to manually weed through them. Of
course, any action that deletes the remote copy is only available on an incoming filter.

It is important to note that if filtering is stopped, no later actions will be performed and no more
filters will be run on the message.

Stop Filtering - This action stops all further filter application to the message. No further
information is needed.

Add to Address Book - This action adds the senders name and e-mail address to an address
book. You will need to enter the name of the address book to add the person's name to in the
entry field that will appear to the right of the action.

Add to Group - This action adds the senders e-mail address to a Group List (or distribution list.)
You need to enter the name of the group to add the person's name to in the entry field that will
appear to the right of the action.

Distribute to Address Book - This action sends the e-mail to everyone in an address book.
You will need to enter the name of the address book to send the message to in the entry field that
will appear to the right of the action.



Distribute to Group - This action sends the e-mail to everyone in an Group List. You will need
to enter the name of the Group List to send the message to in the entry field that will appear to
the right of the action.

Remove from Address Book - This action removes the senders name and e-mail address from
an address book. You will need to enter the name of the address book to remove the person's
name from in the entry field that will appear to the right of the action.

Remove from Group - This action removes the senders e-mail address from a Group List (or
distribution list.) You need to enter the name of the group to remove the person's name from in
the entry field that will appear to the right of the action.

Save Attachments to Directory - This action saves all of the attachments in the filtered e-mail to
a directory that you specify in the entry field that will appear when you choose this action.

Please note that if an attachment already exists in that directory with the same name as one
about to be saved by the filter, it will be overwritten by the new attachment and you will receive no
warning or prompt to not overwrite it.

Filter Settings , Table of Allowable Actions , ICSL Syntax Reference , ICSL Language Reference , ICSL
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Table of Predefined Variables for Filters and Canned Replies

These variables can be used in Canned Replies, Search Strings for filters and in the printer setup. ltis
noted what each of the predefined variables represent, and in which of the three places they are
supported in the table below.

It is important to note that with the new ICSL 2.1, you cannot simply use a dollar sign ($) anymore. the
'$' now represents a variable, and thus to use a single '$' you must type in double dollar signs ($$),
otherwise the dollar sign will be striped out. If a variable is unknown, misspelled, or not supported, it will
be left in the text exactly as you typed it in.

These variables are formatted much in the same way as ICSL tags are. There are several main tags, but
for simplicities sake, only the short version will be used in the table below. You can, however, use either
the long word, or the single letter description (like in the table) when using a predefined variable. The
main tags are as follows (all tags and variables are NOT case sensitive):

H or HEADER

A or ATTACHMENTS

M or MESSAGE

B or BODY

C or CURRENT
CURSOR

S or SIGNATURE

AB or ADDRESSBOOK
AG or ADDRESSGROUP
PAGENUM

0 The "Applies To" column of the table designates where the variable can be used. The "F" stands for
Filters (in the search string), the "C" stands for Canned Replies (in the canned reply text definition), and
the "P" stands for Custom Printing setup (PMMail->Settings->Print Setup). In the table below, "Inserts"
means that it replaces the variable and the enclosing dollar signs with the string in the description.

VARIABLE DESCRIPTION Applies To
$h$ Inserts the whole header. C
$h.quote$ Inserts the whole header, quoting each line with the C
account's default quoting character(s).
$h.fromname$ Inserts the real name of the sender. C
$h.fromid$ Inserts the e-mail address of the sender. C
$h.toname$ Inserts the real name of the receiver(s). If there is more C
then one, a comma separated list of all of the receivers is
generated.
$h.toid$ Inserts the e-mail address of the receiver(s). If there is C

more then one, a comma separated list of all of the
receivers is generated.

$h.datedate$ Inserts the date that the e-mail was sent in the format C
YYYY-MM-DD

$h.datetime$ Inserts the time that the e-mail was sent in the format C
HH:MM:SS. A 24-hour clock is used.

$h.headerline$ Fill in headerline with any line in the header. Ifitis F CP

available in the header, it will be inserted just as it appears
in the e-mail message.

$m$ Inserts the whole raw e-mail message (header, body, C
attachments, encoded data, etc).



$h.quote$

$b$
$b.quote$
$c.date$
$c.time$
$c.acctname$

$c.acctid$

$cursor$

$s.signame$

$a.filename$

$pagenum$
$ab$

$ab.bookname$

$ag$

$ag.groupname$

Inserts the whole raw e-mail message (header, body,
attachments, encoded data, etc), quoting each line with
the account's default quoting character(s).

Inserts the whole body.

Inserts the whole body, quoting each line with the
account's default quoting character(s).

Inserts the current date.

Inserts the current time.

Inserts the account's real name (same as the real name
on outgoing e-mails from the account) or the account that
this message is in.

Inserts the account's e-mail address for the account that
this message is in.

Once the Canned Reply is inserted into the message
window, the cursor is placed wherever the last $cursor$
tag is located.

Fill in signame with the name (description) of one of your
signatures to set it as the active signature for a canned
reply. The last $s$ tag to be encountered will define
which signature is eventually used when the message is
send.

Fill in filename with the full path and filename of a file you
wish to attach to the Canned Reply. You can use this tag
up to 16 times for a total of 16 attachments in a single
Canned Reply.

Inserts the current page number.

Using this variable on the right side of a filter expression
will take the search range (left side of the expression) and
look it up in the entire address book manager. If the left
side is in your address book then it returns TRUE,
otherwise, it returns FALSE. The Alias, Real Name, and
E-Mail Address Fields of the address book are searched.
Fill in bookname with the name (description) of one of
your address books and the search range (left side of the
expression) is looked up in the specific address book you
have it search. If the left side is in your address book
then it returns TRUE, otherwise, it returns FALSE. The
Alias, Real Name, and E-Mail Address Fields of the
address book are searched.

Using this variable on the right side of a filter expression
will take the search range (left side of the expression) and
look it up in all address groups that.you have in your
address book manager. If the left side is in a group then
it returns TRUE, otherwise, it returns FALSE.

Fill in groupname with the name (description) of one of
your address groups and the search range (left side of the
expression) is looked up in the specific address group you
have it search. If the left side is in your address book
then it returns TRUE, otherwise, it returns FALSE.
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ICSL Reference

PMMail’s filter support now includes a scripting language for more complex filters, Blueprint
Software Works's Internet Communication Search Language (ICSL.) ICSL is a powerful scripting
language, designed specifically for searching Internet Email and Usenet News messages.

The ICSL is used to define the search expressions for "Complex" filters. The following is the
definition of the language.

Boolean filters search for two or more search terms, which are connected with the Boolean logic
connectors, AND and OR.

ICSL also contains a negation operator (unary NOT) to allow you to specify search terms which
must not appear in the message, while searching for a match, for the filter to “hit”. The following table
shows the operators and their meaning for use in an ICSL filter.

Operator Symbol
AND &
OR |
NOT !

The words AND, OR and NOT may not be used in place of
the symbols. If they are, a syntax error will result.

Grouping search expressions with parenthesis, including nested grouping, is fully supported, as a
means for the user to define a compound expression within an expression. Search expressions without
parenthesis are grouped from right to left.

0 Search Term
The search term for a filter is an expression. An expression may consist of one or many

expressions, joined via the Boolean operators, & (AND) and | (OR), and may be inverted using the unary
operator ! (NOT.) At a minimum, an expression must contain a Tag, an Evaluator, and a String.

Square brackets are used below to show optional elements, and must not be included in the
written search expression.

0 Tag[.Field] [.Flags] Evaluator "String"

0 The Tag identifies the portion of the message to be searched, and may optionally be followed by a
Field and Flag(s).

1 Fields allowed are dependent on the Tag selected, and will be discussed in more detail with their
respective Tags.

2 Flags modify the search parameters for the expression, allowing case sensitive or insensitive
searching, as well as requiring matches to be on whole word boundaries.

3 The Evaluator part of the expression must be present. Evaluators are one of three symbols “="
(equal), “<” (less than), or “>” (greater than.) Only one symbol may be used as an evaluator in an
expression. Except where noted below, only the “=" Evaluator is legal.

In ICSL, there are three levels of precedence. The evaluators have the highest precedence. The !



operator has the second highest. The lowest precedence is shared by the & and | operators, which are
evaluated from right to left. So the expression:

0 'h.to="abc" & h.to="xyz" | h.from="def"
1 is equivalent to:

2 (! (h.to="abc")) & ((h.to="xyz") | (h.from="def"))

0 The string to be searched for must appear in quotes. Inside the quoted string, any character may
be used, including characters that would have special meaning outside the quotes, such as the
parenthesis, Boolean, or evaluator operators. Inside the quoted string, only an escape operator “\”
(backslash) is observed. This permits quoting the " (quote) character inside a string.

For example, the search string "Icon "The Innovator™ would be:

0 "Tcon \"The Innovator\"".

Variables in Search Strings!!! In simple and complex filters we now finally offer the ability to use certain
predefined variables in search strings. So, you can have a filter catching messages where the To: field
and the From: field are the same. As well, you can use the variables to access current time and dates,
as most importantly, you can use them to look people up in your address book and act if the are or are

not in there. Click here to see a full list of variables, as well as some do's and dont's about special
characters Actions that you now cannot use in the strings without a bit of padding and care.

0 Eilter Settings , Table of Allowable Actions, ICSL Syntax Reference , ICSL Language Reference ,
ICSL Tips and Examples



ICSL Allowable Tags, Fields, and Flags

0 The Tag defines where, in the message, to search for the string.

1 Recognized Tags
A or Attachment
0 B or Body
1 H or Header
2 M or Message
3 OorOS
4 P or PROGRAM
0 Tags are not case sensitive.
Fields

0 Allfields are optional. If the field is omitted then the entire portion of the message indicated by the
tag is searched. (The exception is the A tag, which simply tells you if the message has attachments.)

1ent Tag:
Field Description (scope of message searched)
Name Attachment Names
Type Attachment Type, as in MIME type / subtype
Subtype Attachment subtypes, as in MIME type / subtype
Encoding Attachment encoding method as in Base 64,
Uuencoding, BinHex, Apple Double, Quoted Printable
Charset Attachment Charsets
Header The MIME headers of each attachment

17 Note: For the Attachment Tag type, if any single attachment in the message meets the search criteria,
it is considered a match, and the filtering actions will be performed. The encoding strings that may be
searched for are:

8BIT

0 7BIT

1 QUOTED-PRINTABLE
2 X-UUENCODE

3 BASEG4

4 MAC-BINHEX40

Encoding string searches are not case sensitive.

0__If nofield is specified, a search string must appear with the word YES (Remember, search strings are
always in quotes.)

1 Example: To make a filter that will match any message with any attachments, you would use the
following expression: a="YES" (or attachment="YES")

2 The B or Body Tag:

a
a

Description (scope of message searched)
Attachment Type, as in MIME type / subtype

iel
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Subtype Attachment subtypes, as in MIME type / subtype

Encoding Attachment encoding method as in Base 64,
Uuencoding, BinHex, Apple Double, Quoted Printable
Charset Attachment Charsets

14 Note: For the Attachment Tag type, if any single attachment in the message meets the search criteria,
it is considered a match, and the filtering actions will be performed. The encoding strings that may be
searched for are:

8BIT

0 7BIT

1 QUOTED-PRINTABLE
2 X-UUENCODE

3 BASEG4

4 MAC-BINHEX40

Encoding string searches are not case sensitive.

0 The H or Header

1 This field is used to limit the search to specific header lines

2 Examples:

H. to specifies the To: header lines

H.reply-to specifies the Reply-To: header lines

0 Warning: The : (colon) cannot be used when specifying a header field to search for.

1__Six fields can be used that do not directly return what was retrieved from the header. These are the
Date, Time, Fromname, Fromid, Toname, and the Toid fields. The Date field returns the date as a
string with the following syntax: YYYy-MM-DD (e.g. the string “1999-01-05" would represent January 5th,
1999) . When performing comparisons, you must use this format. YYYY is four digit year (i.e. 1996.)
MM and DD must always be two characters long (i.e. May 7th, 1996 would be 1996-05-07.)

2 The TIME fields has the following syntax: HH:MM: SS. Again, this format must be used. Also, each

part must be two characters long and PMMail. uses the 24 hour clock (00:00:00 - 23:59:59.) Noon is
defined as 12:00:00.

3___The Fromname and Toname returns the real name portion of the e-mail address of the from and to
header lines respectively.

4 The Fromid and Toid returns internet e-mail address portion of the from and to header lines
respectively.

5 Both of these fields may use the < (less than) and > (greater than) Evaluators.

6 The M or Message

7 __The only recognized Field for the Message Tag is Size (compares the size of the message to what is
specified

8 This Field may use the < (less than) and > (greater than) Evaluators.




9 All predefined fields (including all header Fields) are searched without regard to case.

10 The O or OS Tag:

11_The primary use for this tag is for those who are running both the OS/2 and Windows Version of
PMMail on the same data set. This tag can be used to run certain filters only when you are in a certain
Operating System. As well, you can use these filters to retrieve system information and use that
information to perform conditional actions.

12 If no Field is used, the OS tag returns a string defining what operating system you are running, either
“WINDOWS” or “OS/2”, depending on what operating system you are currently running.

Field Description (scope of message searched)

Type In Windows: “NT” or “95”, depending on what you are
running
16 In OS/2: “WARP” or “NOWARP”

Version The version of the operating system you are running,
in the form MajorVer.MinorVer (i.e. 4.0 for the current
version of NT)

Major Major Version of the Operating System you are

running (ie. NT 3.1 and NT 3.51 would both have “3”
as their major version number)

Minor Minor Version of the Operating System you are
running.

Buil The build number of the operating system you are
currently running

Service The Fixpack or Servicepack level of the operating

system

29 Example: To make a filter that, if everything else matches, would only run on a Windows 95 machine
(perhaps the action for this filter is to run a windows 95 program): (YOUR WHOLE FILTER WRPAPED IN
PARENTHESES) & (OS="WINDOWS” & OS.TYPE="95")

30 Another good use for this taq is if you need the filter to only perform the action if the OS is up to a
certain fixpack (Say Windows NT 4.0, SP3) level, you could use: (YOUR WHOLE FILTER WRAPPED IN
PARENTHESES) & (OS="WINDOWS” & OS.TYPE="NT” & OS.MAJOR="4" & OS.SERVICE="3")

31 The P or PROGRAM Tag:

This will allow you to run a program on the message being filtered and use it's return value as
0 a boolean test in the filter. It's syntax is:

1_PROGRAM.<pathandfilenameofprogram>[.FLAGS]="STRING"

2 You must have the program name, and the pointy braces around it. All flags work with this tag. The
program you call is passed the name of the message file as well as a blank file where it needs to write it's
return value/information to. This file is then compared against the "STRING" you are searching for.

0 _Flags

S case sensitive search
0 e match whole word (or exact match)




1 b this stands for Beginning, and the string must match the beginning of the string
you are looking at. IE it is a WORD* match.

2 z this stands for End, and the string must match the end of the string you are
looking at. IE itis a *WORD match.

Only one of -b, -z, and -e can be used, as they contradict each other. -e is the same as a -b AND -z
search together.

0 Each Flag must be preceded with the - (dash) symbol. So, an expression with both flags would look
as follows:

header.subject.-s-e="PMMail"

0 This sample would search the subject line of the header for the whole word PMMail with

that specific capitalization.

0 Please see ICSL Tips and Examples for more examples on how to define complex filters with the
ICSL.

1 Filter Settings , Table of Allowable Actions , ICSL Syntax Reference , ICSL Language Reference |,
ICSL Tips and Examples




ICSL Tips and Example Filters

0 Sample Filters

1 The unless construct can be implemented with the &! (AND NOT) syntax in ICSL. An expression
that would match if the message had PMMail in the subject, unless it was from
pmmail@blueprintsoftwareworks.com would be defined as follows:

2 (header.subject.-s="PMMail") & !(header.from="pmmail@blueprintsoftwareworks.com")

3 Alternative ways to define the exact same filter:

e h.subject.-s="PMMail" & 'h.from="pmmail@blueprintsoftwareworks.com"

¢ header.subject.-s="PMMail" & !(header.from="pmmail@blueprintsoftwareworks.com")

¢ (h.subject.-s="PMMail") & (!h.from="pmmail@blueprintsoftwareworks.com")

0 An expression that would match if the size of the message was greater than or equal to 20000 bytes
would be:

1 message.size>"20000" | message.size="20000"
2 Alternative ways to define the same expression:

¢ m.size>"20000" | m.size="20000"
e | m.size<"20000"

0 An expression that would match if the date was in 1996 or the message was sent during the work day
(after 9 am and before 5 pm) would be defined as follows:

(h.date>"1995-12-31" & h.date<"1997-01-01") | h.time>"09:00:00" & h.time<"17:00:00"

0 Note: Check the parentheses in this expression, they are very important in defining a complex filter.
1 To define the opposite of the previous expression (one that matches if the message was NOT sent
during business hours and NOT sent in 1996) is easy! Just take the above and place a NOT (!) symbol
in front of the whole thing (and wrap the expression in parentheses) as follows:

! ((h.date>"1995-12-31" & h.date<"1997-01-01") | h.time>"09:00:00" & h.time<"17:00:00")

0 An alternative to that, is to define the filter outright, as follows:

1 ((header.date>"1996-12-31") | (header.date<"1996-01-01") ) & ((header.time<"09:00:00") |
(header.time>"17:00:00") )

2 or more simply as: lh.date="1996" & h.time<"09:00:01" | h.time>"16:59:59"

3 Eilter Settings , Table of Allowable Actions , ICSL Syntax Reference , ICSL Language Reference ,
ICSL Tips and Examples



View Attachments Dialog

0 The Attachments dialog will pop up upon choosing Message -> View Attachments from the menu.
Inside the dialog (if there are attachments) you will see icons representing the attachments in the

message for which this dialog has been displayed. You can manipulate the icons just as if they were in
the Attachment Pane of a Read Message Window.



Bounce Message Addressing Dialog

0 The To field is designed exactly the same as the header region in the built-in editor. The only
difference is the "A" and "D" buttons. These correspond to Adding and Deleting names to and from the
list of people the message is being sent to. The RMB popup menus, and address book resolution fully
works when addressing the e-mail in this dialog.

1 NOTE: Bouncing a message differs from Forwarding a message. When you bounce a message, the
only thing that changes is the To: filed of the header. When you bounce a message, you will not be able
to edit it before it is sent. When you forward a message, you will have the opportunity to edit it.

2 If you have multiple messages selected, all of the messages will be bounced to the person(s)
addressed in this dialog.



Address Book Selection Dialog

0 This dialog is used when you are utilizing PMMail's ability to automatically add addresses to an
address book. You simply select the book you wish to add the address to and select OK. If you wish to
edit the address before it is added, check the "edit first" checkbox before selecting OK.

1 To create new address books on the fly, simply choose the "Create New Address Books. A new
address book will be created, and the message will be moved there.



Folder Selection Dialog

0 The first entry in the dialog (labeled Account) specifies to which account the messages is to be
moved/copied. Once the account is chosen, a list of all the folders (along with their positions in the tree) is
listed in the Folders section, right under the Account setting. Just highlight the destination folder from the
list, and click the "OK" Button to complete the selection.

1 To create new folders on the fly, simply choose the "Create As Root" or "Create As Child". A new
folder will be created in the account that you specified to move the message to.



Verify Which Address To Make the Recipient The Reply

0 The e-mail message that you are trying to reply to has two different addresses listed as destinations
for replies. Click on the destination address to which you want this reply to go. This choice will always
default to the "Reply-To" name. Select OK to continue with the reply.



Creating An E-mail With an External Editor

0 Although you can type the body of the message in an external editor, PMMail must still be told all the
header information for the message. This dialog is designed to obtain all of the information for a
message except for the body text. As well, PMMail allows the ability to perform the same actions and
have the same functionality with the messages (obtained via the button bar and menus) as you do with
internally edited message. Such things as the spell checker, priority setting, and word wrap features are
still available to you, even if the message is edited outside of PMMail.

1 When you are ready to compose the mail, click the third button from the left (Externally Edit) or
choose message->exteranlly edit. Once you have finished the e-mail's body in the external editor, save
it, and close down the editor. You are then brought back to this dialog. The "Compose" button now
reads "Send". Double check all of the header and addressing information and correct any addressing
mistakes or take advantage of PMMail's tools for the built in editor at this time. When you are sure all of
the information is correct, click the "Send" button.

2 For more information on this dialog, refer to the Compose Window. help panel.



Password Verification Dialog

0 If you see this dialog, you have attempted to perform a privileged operation on a password protected
account.

1 Fill in the password field and select OK. If the password is correct, the operation will proceed. If the
password is not correct, you made a mistake typing it or have no reason to be attempting the operation.
Try again, or go away!



Error Notification

0 This dialog is to inform you that an error has occurred within PMMail. It is very likely that PMMail will
not be able to continue the requested operation. If it is your opinion that this dialog indicates a bug,
please copy down the information that it conveys and e-mail it, along with a detailed bug description, to
support@blueprintsoftwareworks.com.



Address Group Selection Dialog

0 Use this dialog to select to which group the user will be added. You can simply highlight a group and
press OK, or you can choose to create a new group. The new group settings page will come up, and the
user will be added to this new group.



PGP Passphrase Dialog

0 You must enter your PGP Passphrase in order for PGP encrypting, decrypting, or signing of a
message to continue. This is the secret passphrase you designated when you created your private key.



Add User ID to a Private PGP Key Dialog

0 This tool can be used to associate the current account’s user ID with a Private (secret) key. All you

need to do is choose the private key to associate to this user ID, and then type in the passphrase for that
private key.

1 This dialog is accessible from the Account Properties, Security tab.



Change PGP Passphrase Dialog

0 This dialog is just like any other “change password” dialog. To change the password, simply type in
the old password, the new password, and the new password again (in the confirm password entry.) This
changes the secret passphrase for a PGP Private Key. If you change it, don’t forget to remember your
new passphrase!



Create a new PGP Private Key Dialog

0 This dialog allows you to set all of the settings, preferences, and passwords associated with your new
PGP Private key. Specifically, there are the following settings:

1 Name: Much like when you are filling out a new e-mail account, this is you real name.

2 E-mail Address: You full Internet e-mail address with domain.

3 Number of Bits: As the dialog says, the larger your key is, the longer it will take for someone to
crack it. However, there is no need to go overboard because the larger your key is, the longer PGP

operations will take. A size of 2048 is large enough for e-mail purposes.

4 Expiration: If there is a date after which you want this key to no longer be usable (i.e. for decoding
messages) type in that date, and the key will expire on that date. Otherwise select “Does not Expire”

5 Passphrase: You need to type in a secret passphrase that defines this key. This passphrase is
more secure if it is not a single word; it should be a phrase or sentence. You will be asked for this
passphrase whenever you need to use the secret key you are creating (i.e. when encrypting, decrypting,
signing, etc.)

6 Confirm Passphrase: Type your passphrase in again, just to make sure there are no typos, etc.



Sign a PGP Key Dialog

0 This tool can be used to sign (entrust) the current address book member's key. All you need to do is
choose which of your secret keys you want to use to sign it, and then type in the passphrase for that
secret key.

1 This dialog is accessible from the Address Properties, Security tab.



Directory Services

0 Description - The Name or short Description of the new LDAP server you are defining. This is the
name that will appear in both the Directory Services dialog and in the Address book Find Facility.

1 Server Name - the IP address or Internet name of the server

2 Server Port - The port to connect to the server above which handles LDAP requests. The standard
LDAP port is 389, but if that is not correct, you may have to ask the operator of the server for help.

3 Log on Using - IF the server requires a logon name and password, check this box and fill in the User
ID and Password fields with a valid username and password for the LDAP server.

4 Maximum Entries to return - This setting will limit the amount of addresses “found” for each search
to this server. If more then the number of entries set are found, the search is stopped and only the first N
people (where N is the number that you set in this field) found are displayed in the search results.

5 Search Time-out - If the server does not respond to the search after the number of minutes set in
this field, then the search is stopped and only the results found up to that point will be displayed to the
user.

6 Search Root - Some servers allow, and other require, a search root. This is usually a country to do
the search against. If you are having trouble with the searches and they are returning errors about the
search root, you will need to have the server operator help you set up this field.



Main Window Keyboard Accelerators

Key

F1

F2

F3

F4

F5

Ctrl + F9
Ctrl + N
Ctrl+R

Ctrl + Alt + R
Alt+F

Ctrl + Alt + A
Alt+R
Alt+U
Alt+8
Ctrl+ M
Ctrl+C

Ctrl +P

Ctrl + A

Ctrl +D

Ctrl + Page Up
Ctrl+ F
Alt+B

Ctrl +S

Alt +A

Action

General Help

Fetch Mail

Close PMMail

Remote Control

Send Queued Messages

Minimize PMMail

Create A New Message

Reply To A Message

Reply To All Recipients Of A Message
Forward A Message

View The Attachments Of A Message
Mark As Read

Mark As Unread

Add The Sender Of A Message To An Address Book
Move Message(s)

Copy Message(s)

Print Message(s)

Select All Messages

Delete Message(s)

Toggle the preview pane On or Off
Open The Find Facility

Bounce Message

Save Message To File

Append Message To File



New Message Window Keyboard Accelerators

0 Window Actions

Key

Ctrl + A
Alt + A
Shift + A
Ctrl+C
Ctrl+D
Alt+ 1
Ctrl +N
Ctrl+ P
Ctrl+ Q
Ctrl+S
Ctrl +V
Esc

F1

F5

Alt + F9
Shift + Ins
Ctrl + X
Alt + X
Ctrl+Z

Action

Select All Text

Attach a File

Open the Address Book

Copy Selected Text to the Clipboard
Remove Selected Attachment
Include a File in the E-mail

Create a New Signature

Print the Message

Check the Spelling of the Message
Save the Message to a Text File
Paste the Text in the Clipboard
Close the Message

Compose Window Help

Send the Message

Minimize the New Message Window
Paste the Text in the Clipboard

Cut the Currently Selected Text
Externally Edit the Message

Undo the Last Editing Action

42 Internal Editor Formatting Actions

Key

Ctrl + E
Ctrl + L
Ctrl +R
Ctrl + B
Ctrl +U
Ctrl+ 1

Action

Center Justify Text

Left Justify Text

Right Justify Text
Toggle Bolding of Text
Toggle Underlining Text
Toggle ltalicizing Text

58 Spell Checker Actions



Key

Alt+D
Alt+ G
Alt+N
Alt+P

Action

Add Word to User Dictionary
Ignore this Instance of the Word
Change this Instance of the Word
Stop Spell Checking



Read Message Window Keyboard Accelerators

Key Action

F1 General Help

F7 Delete And Close

F8 Delete And Up

F9 Delete And Down

F11 Up

F12 Down

ESC Close The Message Window

Ctrl+R Reply To The Message

Ctrl+ Alt +R Reply To All Recipients Of The Message
Alt+F Forward The Message

Ctrl +S Save The Body Of This Message To A File
Alt+A Append The Body Of This Message To A File
Alt + X Externally Edit The Body Of The Message
Ctrl+P Print The Message

Ctrl+F Find Text Within The Message

Ctrl + N Start A New Message

Ctrl +Alt+ S Save The Selected Attachment

Ctrl+ O Open The Selected Attachment

Alt+8 Add The Sender Of The Message To An Address Book
Ctrl+V View The Full Header Of The Message
Alt+V View The Full Message Text

Ctrl + A Select All Text

Alt + B Bounce Message

Shift + ctrl + A Open The Address Book

Alt+ G Add Sender of the Message to a Group

N Next Message (Down in the List)

P Previous Message (Up in the List)

F3 Find Next Occurrence of Search Text

Alt + F9 Minimize the Read Window

SPACE Advances to the Next Screen of Text (like Page Down), if you
are at the bottom of the message, the Next Message (Down in
the List) is Viewed.



Address Book Manager Keyboard Accelerators

Key

F1

F9

ESC

Ctrl + Alt + N
Ctrl+Alt+D
Ctrl +Alt+S
Ctrl +N

Ctrl + M
Ctrl+C
Ctrl+D
Ctrl+ S

Alt +A
Alt+B

Action

General Help

Minimize the Window

Close The Address Book Manager
Create A New Address Book

Delete Address Book

Open An Address Book's Settings
Create A New Address Book Member
Move A Member

Copy A Member

Delete A Member

Open A Member's Settings

Create A Message Addressed To All Members Of A Book

Create A Message Addressed To A Member



Remote Control Window Keyboard Accelerators

Key

F1

F9
ESC
Ctrl + L
Ctrl +T
Ctrl + M
Ctrl+C
Ctrl+D

Action

General Help

Minimize the Window

Close The Remote Control Window
Refresh The List Of Headers

Transfer Malil

Mark To Receive A Message

Mark To Receive A Copy Of A Message
Mark To Delete A Message



TCPI/IP Error Codes

Error

10001
10003
10004
10006
10009
10013
10014
10022
10024
10032
10035
10036
10037
10038
10039
10040
10041
10042
10043
10044
10045
10046
10047
10048
10049
10050
10051
10052
10053
10054
10055
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Description

Not owner

No such process

Interrupted system call

No such device or address

Bad file number

Permission denied

Bad address

Invalid argument

Too many open files

Broken pipe

Operation would block

Operation now in progress
Operation already in progress
Socket operation on non-socket
Destination address required
Message too long

Protocol wrong type for socket
Protocol not available

Protocol not supported

Socket type not supported
Operation not supported on socket
Protocol family not supported
Address family not supported by protocol family
Address already in use

Can't assign requested address
Network is down

Network is unreachable

Network dropped connection on reset
Software caused connection abort
Connection reset by peer

No buffer space available

Socket is already connected



(10057) Socket is not connected

(10058) Can't send after socket shutdown
(10059) Too many references: can't splice
(10060) Connection timed out

(10061) Connection refused

(10062) Too many levels of symbolic links
(10063) File name too long

(10064) Host is down

(10065) No route to host

(10066) Directory not empty

(10100) Operating System Error
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Address Book Import/Export Comma Separated Value Format

0 The format for the Imported/Exported Comma separated file in the Address book is as follows. There
is one address book entry per line in the file.

1 For Address Groups the format is as follows with each field separated with a comma.

Grp (the exact text of Grp),

email addresses (each address should be separated by a semicolon (;)),
alias,

group name,

on popup menu (this field is either a one (1) or a zero (0)),

description

o

For Individual Addresses, each field separated with a comma.

Adr (the exact text of Adr),
email address,

alias,

name,

on popup menu (this field is either a one (1) or a zero (0)),
company name,

job title,

home street address1,
home street address2,
home city,

home state,

home zip code,

home country,

home phone,

home phone extension,
home fax,

business street address1,
business street address2,
business city,

business state,

business zip code,
business country,
business phone,

business phone extension,
business fax,

notes

NOTE: A field with a comma in the text must be wrapped in quotes. To include a quote
symbol in a field, use a double quote (")



Command Line Arguments (Switches)

1) Isrd makes PMMail switch to the directory into which it was
installed or passes other command line options to a currently running
PMMail in that directory

2) Imsg <full path to file> opens PMMail and then opens a read window
with that message

3) mailto:<email@company.com> will open a compose message with that

e-mail address in the To: field. You can also use the subject and the body attributes with this tag to
predefine the subject of the message and/or the body of this message. This is done in standard URL
parameter notation as follows: mailto:<email@company.com>?subject=TYPE SUBJECT
HERE&body=TYPE BODY HERE

1) <file name> will open a compose message with that file attached

1) /s specific which account should be used as the “startup account” or the account that has the focus at
startup. Use the directory name to specify the startup account (e.g. pmmailw.exe /s coches_0.act)

So to make the current running copy of PMMail (assuming its working
directory is the install directory) send a message to me with your
CONFIG.SYS (on drive e) attached you would type:

PMMailw.exe /srd mailto:cochese@vr.com E:\Config.sys



Registering Your Copy of PMMail 2000

PMMail has a built in Purchase Wizard that will generate an order form for you, and obtain all necessary
information. When it is finished, it will tell you exactly how to contact our distributor, and with what
information you will have to provide.

Once your copy of PMMail is paid for, you will receive an e-mail that includes your registration key. This
e-mail, and this key is your proof of purchase. You may need it in the future, so print it out and hang
onto it. This e-mail will instruct you on how to quickly and easily enter your key into PMMail 2000. Once
your key is entered, your copy of PMMail will not time out for any reason.

To access the purchase Wizard and begin your registration process, go to the Help menu from the main
window and highlight the Register PMMail 2000 option. You will then be presented with two choices.
Choose the Purchase PMMail 2000 option. So, you need to go to Help->Register PMMail 2000-
>Purchase PMMail 2000 and then purchase wizard will start up!

If you would like to purchase PMMail using non-US funds, or have any purchasing questions, please see
our web site: http://www.blueprintsoftwareworks.com.



Obtaining Further Support for PMMail 2000

For the latest news and further information about PMMail 2000, find us on the web at:

http://www.blueprintsoftwareworks.com/

If you find that your questions are not being answered by using the online help menu or our web site
please email the PMMail support desk. To ensure that you get a speedy response from us, make sure you
include all pertinent information. The support email addresses are:

pmmailwin@blueprintsoftwareworks.com

Please note that we do not offer telephone support at this time, although we are working on a solution for
that and will be offering it in the future. It is also our policy to provide support to all users as quickly as
possible but we do queue support for licensed users ahead of unlicensed users.

If you encounter a problem in PMMail, please let us know! Please use the following guidelines to report
problems and email them to support@blueprintsoftwareworks.com. Following these instructions is
essential to getting the problem properly fixed and a reply sent to you promptly.

Instructions for reporting a problem:

1. Please let us know the exact steps in reproducing your problem. Please provide as many details about
your problem as possible. Please provide the version of PMMail that you use. Include the Windows
version that you use (with service pack), along with any other programs that you frequently run when
PMMail is running, as well as your network setup. For OS/2, please provide the version of OS/2, as well
as your current fixpak level.

2. If you encounter a problem with a specific email message, send us that message as an attachment. Do
not forward the message to us. The problem report will be incomplete without this.



Context Sensitive Help



Minimize To Tray - If this is checked, when the user minimizes the program, you will need to click on the
tray object for PMMail to bring it back up. A button will not appear in the task list for this program when it
is minimized.



Default Character Set - This setting will be used to stamp your outgoing w-mail with the Charset you
used to type it in. This way, the receiver will be able to properly display your message if you use
characters above character 127 in the Charset.



Encoding Format - Choose QP Encoding if you are sending your e-mail over Internet servers that cannot
handle 8bit (only 7bit) defined characters. If you are not sure what to use, this should be the default.
Only choose 8bit if you are sure all of your receivers will get your e-mail in it’s full 8bit glory, converted

first form ASCII to the ISO Internet Charset.



Do Not Perform Charset Translation - Check this option if you want NO preprocessing done on your
characters. If this is turned on, your message will be sent out exactly as you typed it. Be warned that
those in other countries, or those with any sort of different locale configurations that differ from yours may

not properly see the message as you intended.



Automatically Complete E-Mail Addresses - This option will turn on PMMail’s powerful auto-completion
feature. This feature will automatically complete an e-mail address that you begin to type into one of the
three addressing filed (To, CC, BCC). The addresses are completed using the Most Recently Used List
and your address books.



Check To See If PMMail 2000 is your default mailer - If this option is checked, then when PMMail is
first opened, it will see if it is setup as the system wide default mailer for other programs to hook into. If it
is not, you will be prompted if you want to make it your system wide default mailer.



Use Preview Pane - If this option is checked then a read-window-like pane will open under the message
list and will contain the message body of the currently selected message. If you select to mark
messages as read after N seconds, then if a message is viewed in the preview pane for a specific
amount of time (that you specify) it will be marked as read to indicate that you have viewed the message.



Create a new web browser window when launching URLSs - If this option is checked then PMMail will
not use your currently opened web browser session to navigate to the URL, but will instead open a new
web browser window and navigate to the URL.



To show a field that is in the "Fields Not Shown" list, simply select the field you want to show in the list.
When it is highlighted, click the "Show ->" button to move it to the "Fields Shown" list.



To move a header item to the "Fields Not Shown" select the field from the "Fields Shown" list, and click
the "<- Don't Show" button.

The position of the fields that you want to show can be changed. By highlighting and clicking the "Up"
and "Down" buttons under the list, you can change their order in the list. The items listed from top to
button are displayed from left to right in the Main Window.



Select this drop down to choose the font face for Region #1. For a more detailed explanation of this
region, click the Help button below.



Select this drop down to choose the font size (in points) for Region #1. For a more detailed explanation
of this region, click the Help button below.



Select this drop down to choose the font face for Region #2. For a more detailed explanation of this
region, click the Help button below.



Select this drop down to choose the font size (in points) for Region #2. For a more detailed explanation
of this region, click the Help button below.



Select this drop down to choose the font face for Region #3. For a more detailed explanation of this
region, click the Help button below.



Select this drop down to choose the font size (in points) for Region #3. For a more detailed explanation
of this region, click the Help button below.



Select this drop down to choose the font face for Region #4. For a more detailed explanation of this
region, click the Help button below.



Select this drop down to choose the font size (in points) for Region #4. For a more detailed explanation
of this region, click the Help button below.



Select this drop down to choose the font face for Region #5. For a more detailed explanation of this
region, click the Help button below.



Select this drop down to choose the font size (in points) for Region #5. For a more detailed explanation
of this region, click the Help button below.



Type the fully qualified path and filename of the program you want to use to display attachments that
have no other associations. Click the Help button below for more information on this topic.



Click this button to browse your system for the program to use to display attachments that have no other
associations.



Check this option to enable the Program open hook. If this option is not checked, the program will not
run when PMMail is started.



Type the fully qualified path and filename of the program you want to run every time PMMail is started.
Click the Help button below for more information on this topic.



Click this button to browse your system for the program to run every time you start up PMMail.



Check this option so that the program that PMMail will run when it is started, runs in the foreground. If
this is not checked, this program (if enabled) will run in the background.



Check this option to enable the Program close hook. If this option is not checked, the program will not
run when PMMail is closed.



Type the fully qualified path and filename of the program you want to run every time PMMail is closed.
Click the Help button below for more information on this topic.



Click this button to browse your system for the program to run every time you close down PMMail.



Check this option so that the program that PMMail will run when it is closed runs in the foreground. If this
is not checked, this program (if enabled) will run in the background.



This file is the file where you store all of your public keys that you collect using PGP. Type in the full path
and filename of the file you want to use as your public keyring file, or click the Browse button to manually
search your hard drive for the file.



This file is the file where you store all of the private (secret) keys that you create for your user IDs using
PGP. Type in the full path and filename of the file you want to use as your private keyring file, or click the
Browse button to manually search your hard drive for the file.



This file is where PGP obtains its random number generator’s seed. Type in the full path and filename of
the file you want to use as your random seed generator file, or click the Browse button to manually
search your hard drive for the file.



This will be the exact text that appears in the account / folders tree pane of the PMMail Main Window.



Enter your full Internet e-mail address in this space.
Example: cochese@yvirtual.reality.com



Enter your full real name or preferred nickname here.
Example: Frances Steven Oren Cochese, lll.



If you want replies to your e-mails to go to a different account with a different real name, enter that
information here. Otherwise, make sure that this information is the same as the "From Information" you
typed in above.



This choice enables the POP3 (Post Office Protocol3) fetching protocol. This means PMMail will check
for e-mail on a remote server by logging in to your mailbox. Click Help for a more detailed explanation.



This is the machine name of the e-mail server on your network.



This is the port that you need to connect to download your e-mail. Unless you know the port to be
different, it should be the standard POP port of 110.



This is your e-mail user ID (or Login ID.) Make sure all proper punctuation and capitalization is
observed. Do not put your full Internet e-mail address, but only your login name (usually what appears
before the @ symbol.)



Type in your e-mail password (or Login Password.) Do not worry, this password will not be displayed on
the screen, or anywhere else.



If you would like to leave messages larger then a certain size on the mail server, check this.



Use this to specify the minimum size message you want to leave on the server with the up/down arrows,
or by typing in the value.



If you would like to leave all messages on the server, and only download copies of the messages
during a "fetch", check this option.



The Reset button will make PMMail fetch all e-mail that is on the server during the next fetch cycle (all
mail will still remain intact on the mail server.)



This choice enables the SMTP (Simple Mail Transport Protocol) fetching protocol. This means PMMail
will check for e-mail on your local machine. Click Help for a more detailed explanation.



This is the fully qualified path to where the e-mail is stored on your machine. You will fetch mail from this
directory if you have turned on SMTP fetching.



To open PMMail's Remote Control Window and perform a manual customized fetch upon every
fetch attempt, check the "Receive Using Remote Control" option.



To enable this account to automatically fetch after a given duration of time, check the "Check For
New Mail..." option,



Use this to set the number of seconds that the account should wait before attempting to refetch the e-
mail. Note that this account need not be active for this option to be operating in the background. All
accounts with this option enabled will work throughout the duration of a PMMail run.



For SMTP sending, make sure the circle next to the SMTP text is filled in by clicking in the circle.



Fill in the machine name of your network’s mail server



Type in the port number that you connect to on your server to send e-mail. If you are unsure, use the
default port of 25.



To send using the POP Protocol make sure this option is selected.



Type in the POP server name that you will be connecting to in order to fetch e-mail.



Type in the port number for the server specified above that you will connect to for POP Services.



Type in your user ID for this server.



Type in your Password (associated with the user ID specified above.)



To enable the Word Wrapping options, click in this box.



This choice sets the wrapping to a user specified amount of characters.



Use the up and down arrows to set the number of characters at which you want your text to wrap.



Select this for WYSIWYG wrapping. WYSIWYG wrapping uses the width of the editor to determine
where the text will get wrapped.



If you want to always have the character formatting bar in the internal editor, select this option. If this
option is turned off, then your e-mails will be sent out as plain text, and no HTML encoded formatting. If
formatting exists, it will be lost when you send the message.



If you want PMMail to keep a copy of every e-mail you send in the Sent folder, check the “Save copy of
outgoing mail” option.



If you want PMMail to try to send any e-mail that is queued for sending in the Outbox after every fetch,
check the “Send after fetch” option.



To set the default Attachment encoding method, drop the list of Attachment methods and choose one of
the following:

MIME - MIME uses BASEG64 en/decoding. This is a popular newer format for sending to any e-
mail client.

UUEncode - This is an older UNIX encoding technique that many e-mail clients support.

BinHex - BinHex encoding is like BASE64, but has become a standard encoding method for
Macintosh e-mail clients. Very few e-mail clients support this type of encoding.



Create Key Pair: If you do not have a PGP public key/private key pair, pressing this button will create
one. AKkey pair enables others to send you encrypted mail and verify your signature (public key) and
encrypt and sign messages (private key.)



Add E-Mail Addresses To An Existing Key: If you have created a key pair already, pressing this button
will associate this account's e-mail address to that key pair. This will allow both accounts to use the
same key pair, thus simplifying key management.



KeylD: This is the unique identifier for your PGP key. All PGP keys, public or private, have a key id.



Key Size: This is the number of bits used by your public key. The higher the number of bits, the more
secure it is, however, more bits also increase the time required to encrypt, decrypt, etc. a message.



Key Fingerprint: This is a consistency check for your public key. When you send someone your public
key, there is a chance it could become corrupted. If you also send them your key fingerprint, they will be
able to verify the key when they add it to their keyring.



Change Passphrase: If you would like to change your passphrase, pressing this button will bring up a
dialog in which you can change your passphrase. A good passphrase is typically more than eight
characters, with numbers and spaces. (A complete sentence is very secure and easy to remember.)



Use the following passphrase: Selecting this option will make PMMail store the passphrase that you
enter in the shown entry field. While convenient, this option is not secure at all. It should only be used if
you can rely upon physical security of the computer.



Prompt me for my passphrase: This option, when set, will instruct PMMail prompt you for your
passphrase whenever it becomes necessary. This is the most secure option.



Remember my passphrase for the remainder of the session: After being prompted for your
passphrase once, it will be stored in memory until PMMail is closed. This option is usually secure unless
many people have access to your machine who may be able to use memory inspection tools to find the
passphrase in memory.



Sign every outgoing message: When checked, PMMail will digitally sign your outgoing messages.
This digital signature insures other people that the message actually came from you.



Include public key on every outgoing message: When this option is turned on, PMMail will include
your public key at the end of every message you send. Sending your public key to someone allows them
to add this key to their keyring. Once they have your key in their keyring, they can then verify signed
messages from you, as well as send you encrypted messages.



Include public key fingerprint on every outgoing message: With this option turned on, your public
key fingerprint is included at the end of all your messages.



Warn about security issues: When this option is enabled, PMMail will notify you of any possible
security risks that are present.



To always view the full header of an e-mail when reading the e-mail, enable the "View Full Header..."
option.



PMMail will allow you to set the default reply quoting action. Check this box if you do not want the body
of the message quoted in replies by default. If you do want the body quoted, leave this unchecked.



You can also always view the attachment pane of outgoing messages while you are composing them. If
this is desired, check the “View the attachment area of an outgoing message by default” option.



Upon receiving new mail, you can choose to have PMMail audibly notify you with a speaker chime.



Upon receiving new mail, you can choose to have PMMail notify you by playing the sampled sound file
that is specified checking (activating) this option.



Type in the fully qualified path and filename of the sound file you want to play.



Click the button to browse your system for the sound file it should play when you get new mail (if the
option is activated.)



The account can be locked with a password. If enabling this option, remember to type in a password in
the space after the option's text.



Here, type your user defined password to lock this account. This doesn’t have to be the same as you e-
mail login password. Remember this password, it will not be displayed and there is no way to retrieve it
This option will prevent someone from opening the settings of the account, or expanding the account to
see the folders without typing in your password.



Upon PMMail's start-up, the account can be set to Open the account (display the top level folders of the
account.)



Upon PMMail’s start up, you can fetch your mail for this account by checking this option.



Upon PMMail’s start up, you can send any mail waiting to be sent out from your Outbox by checking this
option.



You can have PMMail automatically empty e-mails in your trash folder after they become a certain
number of days old. Select this option to turn this deleting style on. The deletions will occur at program
shutdown. This will permanently remove all e-mails in the Trash folder from the hard drive.



Use this to set the number of days to wait before removing an e-mail. If you select “0”, your trash folder
will always be emptied at shutdown.



You can have PMMail perform what are known as "True Deletes". When this option is checked, the
messages are not moved into the trash folder upon deleting them, instead they are removed immediately
from your hard drive.



If this option is enabled, when you want to exit the program, you must click "OK" in the verify dialog.



If this option is enabled, if you try to close the compose window before you issue a send, you must verify
that you actually want to cancel this massage.



If this option is enabled, to remove this account, you must verify that you really want to delete it before
PMMail will let you.



If this option is enabled, to remove a folder, you must confirm it.



If this option is enabled, before PMMail will allow you to delete a message, you must verify this action.



If this option is enabled, with this verification turned on, PMMail will prompt you if a file already exists with
the same name as the attachment. If you select YES, the file will be overwritten, otherwise, no decoding
is performed. If you do not have this verification turned on, PMMail will not perform any decoding if it

finds that a file with the same name already exists.



Selecting this option causes your messages to be automatically spell checked when you hit the 'send’
button.



Selecting this option causes text that you have quoted in your message (from the message you are
replying to), to be exempted from spell checking.



This option will cause words that are all in caps, such as "USENET" and “SMTP”, not to be spell checked.



Checking this option will cause words containing numbers, like "20th", to be exempted from spell
checking.



Use this area to enter partial words that you wish to be used to disqualify words for spell checking.



Click this button to add the pattern you typed in the space to the left to the active patterns to skip when
spell checking.



Click this button to remove the selected pattern from the space below from the active patterns to skip
when spell checking.



This is the list of active patterns to skip when spell checking a word. To remove a pattern, highlight it and
click the remove button above.



To use PMMail's built-in editor, you must make sure that this is the option chosen. Otherwise, an
external editor will be used.



To Use an external editor, you must click the circle next to the text and provide PMMail with the following
information about the external editor:



The full program name of the editor (example NOTEPAD.EXE for NOTEPAD.)



Click this button to browse your hard drive for the editor to use instead of the PMMail Internal Editor.



The command line arguments and switches. These arguments will be passed to the editor when it is
opened. Place a %s where the name of the input file appears in the command line parameters.



You must choose for which actions (Reading only, Composing only, or both) the external editor is to be
used.



Click this button to create a new signature with the PMMail Signature Editor.



Click here to edit the currently selected signature from the list to the left.



Click here to delete the currently selected signature from the list to the left.



This is a list that shows all of your signatures. Select one to of the signatures in the list to make it the
signature that the action buttons in this dialog will act on.



Click this button to make the currently selected signature the default signature.



Click this button to make no signature the default signature, thus no signature will be appended to your e-
mail by default.



Click this button to create a new canned reply with the PMMail Canned Reply Editor.



Click here to edit the currently selected canned reply from the list to the left.



Click here to delete the currently selected canned reply from the list to the left.



This is a list that shows all of your canned replies. Select one to of the canned reply in the list to make it
the canned reply that the action buttons in this dialog will act on.



Click this button to create a new filter with the PMMail Filter Editor.



Click here to edit the currently selected filter from the list to the left.



Click here to delete the currently selected filter from the list to the left.



This is a list that shows all of your filters. Select one to of the filters in the list to make it the filter that the
action buttons in this dialog will act on. The order that these filters appear in the list is the order in which
they are applied to the messages.



Click this button to move the selected (from the list above) filter up in the list. This will change the order
in which the filter is run on the message, making it run sooner.



Click this button to move the selected (from the list above) filter down in the list. This will change the
order in which the filter is run on the message, making it run later.



Check this option to enable the Program send hook. If this option is not checked, the program will not
run when PMMail send messages.



Type the fully qualified path and filename of the program you want to run every time PMMail sends a
message. Click the Help button below for more information on this topic.



Click this button to browse your system for the program to run every time you send a message with
PMMail.



Check this option so that the program that PMMail will run when it sends a message will run in the
foreground. If this is not checked, this program (if enabled) will run in the background.



Check this option to enable the Message receive hook. If this option is not checked, the program will not
run when PMMail receives messages.



Type the fully qualified path and filename of the program you want to run every time PMMail receives a
message. Click the Help button below for more information on this topic.



Click this button to browse your system for the program to run every time you receive a message with
PMMail.



Check this option to execute the program that PMMail will run when it receives a message will run in the
foreground. If this is not checked, this program (if enabled) will run in the background.



Check this option to enable the custom send hook. If this option is not checked, the program will not run
when PMMail begins to send a message.



Type the fully qualified path and filename of the program you want to run every time PMMail sends a
message. Click the Help button below for more information on this topic.



Click this button to browse your system for the program to run every time you send a message with
PMMail.



Check this option so that the program that PMMail will run when it sends a message will run in the
foreground. If this is not checked, this program (if enabled) will run in the background.



Check this option to enable the custom receive hook. If this option is not checked, the program will not
run when PMMail begins a batch fetch.



Type the fully qualified path and filename of the program you want to run every time PMMail begins the
fetch process. Click the Help button below for more information on this topic.



Click this button to browse your system for the program to run every time you start the receive process
with PMMail.



Check this option so that the program that PMMail will run when it starts the receive process will run in the
foreground. If this is not checked, this program (if enabled) will run in the background.



This is the name of the group. This name will be used as a short description of the group when you need
to choose it out of a list.



An alias acts as a nickname or shortcut to refer to an address book entry. The alias will be used to call
up the address when entering it into a new message.



A short, one sentence description of why the group exists.



These are the e-mail addresses of each member of the group. As the note below this addressing
window states: you can use address book names, other group lists, or aliases from the address book
along with real e-mail addresses, however, you MUST enter them one line at a time, with no commas
separating member's addresses.



Check this option if you want this group to be added to your quick find right mouse button popup in the
addressing controls.



This must be the full Internet e-mail address.
An example of this would be: cochese@vr.com



This is the Alias that will be used when referring to this address book entry. Aliases can be entered as a
recipient of an e-mail. The Address Book engine will resolve these Alias references.

An example of an Alias for the above e-mail address example would be simply the name:
cochese.



This is the real name of the person whose entry you are adding.



If this is enabled, you can right mouse click in any of the recipient fields in the Compose Window, and a
menu will appear with all of the aliases you have added to this menu.



For the Phone/Address group of entry blanks, you can switch between Home and Business information
for viewing or filling in via the pull down menu for the category you want to fill in. It initially says "Home".
Home or Business information can be entered or retrieved.



Click on this to switch between filling in the Home or Business information. The dialog will remember
both sets of information, so you will not lose data by switching between them.



This is a small editor that will allow you to type in any notes about the user.



Key ID: This is the unique identifier for this PGP public key. All PGP keys, public or private, have a key
id.



Created: The date the key was created.



Expires: The date this key expires, if an expiry date was set.



Key size: This is the number of bits used by this public key. The higher the number of bits, the more
secure it is, however, more bits also increase the time required to encrypt or check the signature of a
message.



Key type: The key type-either RSA or Diffie-Hellman/DSS.



Cipher type: The encryption algorithm that the key uses-either CAST, IDEA, or Triple-DES.



Key fingerprint: This is a consistency check for this public key. When someone sends you their public
key, there is a chance it could become corrupted. If they also send you the key fingerprint, you can verify
the key by comparing the supplied fingerprint to the one shown here.



Validity: This field displays the key's validity-Invalid, Marginal, or Complete. A key becomes more valid
the more you trust the people who have signed it.



Trust: Displays your level of trust in the key-Untrusted, Marginal, or Complete. Trust is a measure of
how much you believe the key actually came from the person to whom it says it belongs.



Validity bar: Displays a graphical representation of the key's validity.



Trust slider: Move the slider bar to assign a level of trust to the key. The farther you move the slider to
the right, the more you trust this key. The farther you move the slider to the left, the less you trust this
key. You cannot adjust the trust of an invalid key.



Enabled: Enables the key. A disabled key cannot be used to perform any PGP action.



Sign key: Pressing this button will allow you to sign this public key (or vouch for it) saying "Yes, | believe
this key is from who it says it's from."






